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Introducing Visualization and
Animation

You can visualize your model's bodies using the Simscape Multibody visualization window.

This overview explains the essentials of starting visualization and choosing body colors
and geometries.

* “About Simscape Multibody Visualization” on page 1-2
* “About Body Color and Geometry” on page 1-5
* “Hierarchy of Body, Machine, and Model Visualization Settings” on page 1-10
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About Simscape Multibody Visualization

In this section...

“Starting Visualization” on page 1-2

“Using Visualization” on page 1-3

Warning This content is specific to Simscape Multibody First Generation software. First-
generation features are slated to be deprecated and should be avoided.

Starting Visualization

Starting Simscape Multibody visualization requires two choices, one for your entire
model, the second for each machine in your model. These choices are part of configuring
your model for simulation, as discussed in “Starting Visualization and Simulation”.
Implement your visualization choices at any time by clicking Apply or OK.

Enabling Visualization for an Entire Model

You enter the visualization settings for an entire model in the Visualization area of the
Simscape Multibody 1G node of the Configuration Parameters dialog. To open
visualization, you must select at least one of these check boxes.

Model-wide visualization is turned off by default.

— Visualization
[ Display machines after updating diagram
[~ show animation during simulation

[ show only port coordinate systems

Default body color (RGE): I [100]

Default body geometries: ICDnvex hull from bedy CS locations ;I

To start visualization, you must select at least one of the first two check boxes:

* Display machines after updating diagram for static visualization
* Show animation during simulation for dynamic animation

1-2



About Simscape Multibody Visualization

Select the Show only port coordinate systems check box if you want to visualize only
those Body coordinate systems with visible ports on their respective Body blocks in the
model. The default is unselected, so that all Body coordinate systems are visualized on
their respective bodies.

Visualizing All Bodies in a Machine
You can choose whether or not to visualize a specific machine in your model through the
Visualization tab of its Machine Environment block dialog. A single window displays all

selected machines in a model.

By default, each machine is selected for visualization. If you turn off machine
visualization, your choice only affects that machine, not the entire model.

Parameters I Constraints | Linearization Visualization |

To enable visualization and animation of connected machine, select 'Visualize
machine.' Visualization andor animation must also be enabled in the SimMechanics
node of the Configuration Parameters dialog.

Iv visualize machine

Default body geometries: IUse model default body geometries

Body color selection mode: |Use model default |

Default body color (RGE): I [100]

Other Simscape Multibody Visualization Controls

All other visualization controls are located on the Simscape Multibody visualization
window itself. You can access them once the window is open.

You control custom visualization choices for individual bodies in their respective Body
dialogs.

Using Visualization

You can visualize a model using a static display or a dynamic animation.

1-3
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Display Versus Animation

Simscape Multibody visualization serves two distinct purposes, static and dynamic. In
both cases, you can change your observer viewpoint and navigate through the scene, as
well as change the visualized body properties.

Static Display

You can display a static state of your model at different stages of modeling. Use static
display in the initial state, during construction. Either:

* Open the visualization before or while you build your model. You display each body as
you add it to your model, if you also update the block diagram.

Having the visualization window open during model building lets you keep track of
your model's bodies and how they are connected. You can see unphysical or mistaken
constructions before you finish the model.

* Open the visualization after you finish the model. All the bodies in the model appear
together.

Also use static display after a simulation ends, or after you pause or stop it. In these
cases, the visualization window shows the model at later times or in the final state.

Dynamic Animation

You can also display an animation of body motion while the Simscape Multibody model is
running. Use this feature to watch the model's dynamics in three dimensions and visualize
motions and relationships more easily than is possible with Scope blocks alone.



About Body Color and Geometry

About Body Color and Geometry

In this section...

“About Body Color: Default and Custom” on page 1-5

“About Body Geometry: Default, Standard, and Custom” on page 1-5
“Standard Body Geometry: Equivalent Ellipsoids” on page 1-5
“Standard Body Geometry: Convex Hulls” on page 1-8

“Custom Body Geometry and External Graphics Files” on page 1-9

Warning This content is specific to Simscape Multibody First Generation software. First-
generation features are slated to be deprecated and should be avoided.

About Body Color: Default and Custom

The initial default color of all visualized bodies is red. You can modify this default or
replace it by custom colors for individual bodies, one at a time. For more information, see
“Creating an External Virtual Reality Client” on page 3-3.

About Body Geometry: Default, Standard, and Custom

You can choose how the visualization window displays the bodies in size and shape
(geometry). There are two available standard geometries:

* Equivalent ellipsoid for each body, based on its mass properties and center of gravity
(CG) position

* Convex hull for each body, based on its Body coordinate systems (CSs)

The convex hull geometry is the initial default body geometry for all visualized bodies.

Standard Body Geometry: Equivalent Ellipsoids

The inertia tensor I of a rigid body is real and symmetric, so it has three real eigenvalues
(I, I, I;) and three orthogonal eigenvectors. These eigenvectors are the principal axes of
the body. In the coordinate system defined by those axes, the inertia tensor is diagonal.
The trace of the inertia tensor, Tr(I) = I;+ I, + I3, is the same in any coordinate system
with its origin at the body's center of gravity (CG).

1-5
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Every rigid body has a unique equivalent ellipsoid, a homogeneous solid ellipsoid of the
same inertia tensor. In Cartesian coordinates, the ellipsoid surface is given by

where m is the body's mass. The three parameters (ay, ay, a,) are the generalized radii of
the ellipsoid. For axisi = 1,2,3,

Triangle Inequalities

The principal moments (I, I,, I;) must satisfy the triangle inequalities:

Violation of the triangle inequality for I; leads to an unphysical imaginary generalized
radius a;.

Caution Visualizing the equivalent ellipsoid of a body whose principal moments do not
satisfy the triangle inequalities leads to a Simscape Multibody warning indicating that
one or more triangle inequalities have been violated. The simulation continues, but the
body in violation is not displayed.

Ellipsoids with Special Symmetry

In general, all three I;, i = 1,2,3, are unequal. Such a body is an asymmetric top. If two of
the three I; are equal (double degeneracy), the body is a symmetric top. The third axis is
the axis of symmetry. If all three I; are equal (triple degeneracy), the body is a spherical
top and dynamically equivalent to a homogeneous sphere.

Reduced-Dimension Ellipsoids

In special cases, the equivalent ellipsoid reduces to a planar, linear, or point figure.

Let (i,j,k) label the three axes (1,2,3) = (x,),2) in any order.

» For a true ellipsoid, with nonzero volume, all the g; are nonzero. The triangle
inequalities are strict inequalities in this case:

* For an ellipse, with zero volume but nonzero area, one g; = 0 and the other two a;, ay
are nonzero. One of the triangle inequalities becomes an equality:
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* For a line, with zero volume and area but nonzero length, two a;, ¢; = 0 and the third
ay is nonzero. Two of the triangle inequalities become equalities:

Equivalently, I; = I; are nonzero and I, = 0.
» For a point, with no spatial size, all three g; vanish. All three triangle inequalities

become equalities:
Equivalently, all three I; vanish.
Visualizing the Simple Pendulum Rod with Equivalent Ellipsoids

Consider the simple pendulum rod in “Visualize a Simple Machine” in the Simscape
Multibody Getting Started guide. You can open the model by entering mech spen at the
command line.

The rod length L = 1 m, and its radius r = 1 cm. The inertia tensor is
Because the rod has an axis of symmetry, the x-axis in this case, two of its three principal
moments are equal: I, = I,,, and two of its three generalized radii are equal: a, = a,. The

rod is a symmetric top and, since r is much smaller than L, its equivalent ellipsoid is
almost a line of zero volume and area.

The generalized radii of the equivalent ellipsoid are a, = = 0.646 m and a; = a, = = 1.12
cm. This is the rod so displayed:
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Standard Body Geometry: Convex Hulls

Every Body has at least one Body coordinate system (CS) at the CG. A Body also has one
or more extra Body CSs for the attached Joints, as well as possible Actuators and Sensors.
Each Body CS has an origin point, and the collection of all these points, in general,
defines a volume in space. The minimum outward-bending surface enclosing such a
volume is the convex hull of the Body CSs, and this is the alternative standard body
geometry. The Simscape Multibody convex hull excludes the CG CS.

To enclose a nonzero volume, this set must have at least four non-coplanar Body CSs.
Three non-collinear Body CSs are displayed instead by a triangle, and two non-coincident
origins by a line. One origin is displayed just as a point.

Four or more coplanar origins are displayed as a triangle, three or more collinear origins
are displayed as a line, and two or more coincident origins are displayed as a point.

Visualizing the Four-Cylinder Engine Crank with Convex Hulls

Open the four-cylinder engine model by entering mech fceng at the command line. Start
visualization.

Open the Engine Block subsystem and note the Crank block representing the engine
crank. This Body block has five coplanar Body CSs, not including the CG CS. Visualize the


matlab:mech_fceng

About Body Color and Geometry

engine as convex hulls and click the Crank body, the largest body. The convex hull forms a
planar polygon.

Engine Block/Crank body

Custom Body Geometry and External Graphics Files
In place of the standard body geometry choices, you can provide a custom geometry

defined with external graphics files for one or more individual bodies. For more
information, see “Customizing Visualized Body Geometries” on page 3-7.

1-9
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Hierarchy of Body, Machine, and Model Visualization
Settings

In this section...

“Visualized Geometries and Colors from Body Block Settings” on page 1-10
“Body Block Settings Affecting Body Visualization” on page 1-11

“Visualization Settings in the Machine and Model Hierarchy” on page 1-12

Warning This content is specific to Simscape Multibody First Generation software. First-
generation features are slated to be deprecated and should be avoided.

Visualized Geometries and Colors from Body Block Settings

The Simscape Multibody visualization window visualizes bodies represented by Body
blocks in your model. The visualization information that the window uses from the model
comes strictly from the mass, coordinate system, and visualization properties set
individually in each Body block's dialog.

Note The window itself contains additional visualization controls that affect visualized
body geometries and colors.

1-10



Hierarchy of Body, Machine, and Model Visualization Settings

SimMechanics model

Body?2 Color2
block [Geometry2

Body?2

-

/
Bodyl Colorl ! Colorl
block |CGeometryl i Geometry1 | DOAYL
|
|
I :j
|
|
'1

—— _r‘_"f'
f WVisualization window \1
controls |
B —

Body Block and Visualization Window Settings Control Body Visualization

Body Block Settings Affecting Body Visualization

How settings in Body block dialogs affect visualization depends on which type of body
geometry and which color you choose for a particular body. The Body dialog contains
three classes of such choices.

Mass Properties

The principal inertial moments and the mass of a body determine the size and shape of its
equivalent ellipsoid.

Body Coordinate Systems: Origins and Orientation

The relative positions of the Body's coordinate systems (CSs) determine the size and
shape of its convex hull.

Visualization

The color choice in the Body dialog's Visualization tab determines the color of the
visualized body.
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You make the choice of convex hull or equivalent ellipsoid to visualize an individual body
in the Body dialog's Visualization tab.

If you choose a custom body geometry for a Body, the external body geometry file
referenced in the Body dialog's Visualization tab determines the visualized body's size
and shape.

Note The choice of standard or custom body geometry has no effect on the visualized
body's color. The choice of body color has no effect on the visualized body's geometry.

Visualization Settings in the Machine and Model Hierarchy

Simscape Multibody models start with initial default visualization settings. A model and
machines within the model also possess, respectively, model-wide and machine-wide
default visualization settings. Visualization settings are inherited from the highest level
(model) through machines to individual Bodies. You can change these default and
inherited settings.

1-12



Hierarchy of Body, Machine, and Model Visualization Settings

SimMechanics model

[ Model-wide visualization default settings: Body color and geometry ]

e T T

Machinel \\ ( Machine? \1

Y

| Machine-wide | | Machine-wide |
| visualization | visualization

defaults: |

defaults: |
Body color

Body color

[
| |
| | |
| | | |
I and geometry | | and geometry | | Lo :
| | -
| . - i |
| : | L |
| Body1 | Boart ||| |
| P ok | | | | ok | | | : |
| Body2 | | Bod | | : |
3 v2
| P oo | 1| PP ewoex ||| |
| o - |
| Ly I | Ly I | |
| : | : | |
N NN /

Inheritance Hierarchy of Default Visualization Settings
Initial Default Settings for a Model
The initial default visualization settings for an entire model are:

* Model-wide default body color: red (RGB value of [1 0 0])
* Model-wide default body geometry: convex hull

Machine Inheritance of Model-Wide Default Settings

The initial default visualization settings for a machine are:
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* Machine-wide default body color: inherit model-wide default
* Machine-wide default body geometry: inherit model-wide default

Body Inheritance of Machine-Wide Default Settings
The initial default visualization settings for a Body are:

* Default Body color: inherit machine-wide default
* Default Body geometry: inherit machine-wide default

1-14



Getting Started with the
Visualization Window

The Simscape Multibody visualization window allows you to control how you view your
model's bodies in both static display and dynamic simulation-based animation. It also
allows you to record animations.

* “Introducing the Simscape Multibody Visualization Window” on page 2-2

* “Controlling Body and Body Component Display” on page 2-6

* “Adjusting the Camera View” on page 2-9

* “Communicating with the Model from the Visualization Window” on page 2-16

* “Controlling Simulation from the Visualization Window” on page 2-20

* “Controlling Animation” on page 2-22

* “Recording Animation” on page 2-27

* “Simscape Multibody Visualization Menus and Their Controls” on page 2-32



2 Getting Started with the Visualization Window

Introducing the Simscape Multibody Visualization
Window

2-2

In this section...

“About the Visualization Window” on page 2-2
“Opening and Updating the Visualization Window” on page 2-2

“Visualization Toolbar and Its Controls” on page 2-4

Warning This content is specific to Simscape Multibody First Generation software. First-
generation features are slated to be deprecated and should be avoided.

About the Visualization Window

The visualization window is an integral part of Simscape Multibody software. With it, you
can visualize your machines using a comprehensive set of display controls, interact with
your model, and watch and record animations.

The window uses a distinctive set of symbols and shapes to display bodies and Body
coordinate systems (CSs). This section is an overview of what you can do with the
Simscape Multibody window.

Caution The Simscape Multibody visualization window resembles a MATLAB® Graphics
figure window. But it is not a feature of MATLAB and has no figure handle.

Opening and Updating the Visualization Window

Starting visualization and choosing the default display options are discussed in “About
Simscape Multibody Visualization” on page 1-2.

* Once you configure your Simscape Multibody model for visualization, select Update
Diagram from the model's Edit menu (or press Ctrl+D).

The window opens and displays the machines in your model that you have chosen to
visualize. One window displays all selected machines simultaneously.
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» To synchronize the static visualization display with your model, reselect Update
Diagram at any time.

This figure shows a model with the default background color.

Desktop
docking button

) Machine for model: mech_fceng
View Simulation Model Help

IR D N s
Toolbar<a @@HSLJH@

Menu bar

B d
ackgroun Display  Ful
window window
World
CSaxes ———
(orientation only)
Status bar

Simscape Multibody Visualization Window Displaying a Four-Cylinder Engine (Isometric
View)

Menu Bar Versus Toolbar Controls

Once you open the visualization window, you have two ways to control the display and
carry out these tasks:



2 Getting Started with the Visualization Window

* Use the buttons in the toolbar. Every feature on this toolbar occurs in the menus,
although the reverse is not true. See “Visualization Toolbar and Its Controls” on page
2-4,

* Use the menus in the menu bar. The menu contains specialized items and submenus.
See “Simscape Multibody Visualization Menus and Their Controls” on page 2-32.

Note Changing the display settings using the visualization window controls changes only
your immediate view in the display window. By itself, it does not change the visualization
settings in the model.

If you want to save a change in the visualization window settings to the model, and thus
change the model's visualization settings, see “Communicating with the Model from the
Visualization Window” on page 2-16.

Visualization Toolbar and Its Controls

You can activate or change most visualization features by selecting buttons on the window
toolbar, instead of selecting items from the menus. The setting changes initiated by the
toolbar are the same as the corresponding menu actions: either you activate a feature,
enable or disable a feature, or initiate an immediate action.

Hovering your mouse cursor over a toolbar button displays the button's tooltip indicating
its function.

2-4
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View: Front
Back
Top
Bottom
Left
Right
Isomefric  Simulation: Start Save AVI
‘ Fit to View ‘aop II|JispIa',r Simulation Time Pause
Save Visualization Settings — | & @ @ @ @ @ E [* & 4 X[ » W P %[0 During simulation: |11 =
to Model = ‘
TR | |
Body Geometries: Convex Hulls ‘ Update Diagram Zoom Expanding Fit Stop
Equivalent Ellipsoids Pan Tight Fit
Individual Body Settings Rotate
Display: Body CGs Set Current Tool: Select
Body CSs

Simscape Multibody Toolbar Buttons
Toolbar Relationship to the Menus

You can access all of the toolbar functions in the menus as an alternative. The toolbar
reproduces most of the menu functions.

See “Simscape Multibody Visualization Menus and Their Controls” on page 2-32 for a
complete overview of the visualization window controls.
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Controlling Body and Body Component Display

2-6

In this section...

“About Body and Body Component Display” on page 2-6
“Interpreting the Body Display Symbols and Shapes” on page 2-6
“Changing Body Display Symbols” on page 2-7

“Changing Body Display Shapes” on page 2-7

Warning This content is specific to Simscape Multibody First Generation software. First-
generation features are slated to be deprecated and should be avoided.

About Body and Body Component Display

You can change how bodies look in the Simscape Multibody visualization window. This
section explains how to control body and body component display.

Interpreting the Body Display Symbols and Shapes

When a visualization window opens, it uses distinctive conventions to display the bodies
of your model.

Body Component Display
Body components are displayed with two distinctive symbols:
* The center of gravity (CG) point of each body is marked by a half-filled circle-plus

symbol e .

* Each Body coordinate system (CS) is marked by coordinate axis triads. The color
coding is X-Y-Z axes = RGB = red-green-blue.



Controlling Body and Body Component Display

Body Surface Display

The window displays all the bodies of every machine with visualization enabled. The
entire body surface is shaded with the color you choose for it. Its shape is one of these:

* Convex hull: a line, one or more joined surface patches, or a closed surface enclosing a
volume

* Equivalent ellipsoid
* A custom shape

Changing Body Display Symbols

You can turn off the CS triads, the CG symbols, or both using the toolbar, with the
Display Centers of Gravity and Display Coordinate Systems buttons.

You can activate or deactivate each button separately. The default for both is active.

RS
/\ \

Body CGs

Body CS triads

Four-Cylinder Engine: Cylinder Piston With and Without Body CS Triads and CGs
(Detail)

Changing Body Display Shapes

You can switch among three possible display shape options using the toolbar. They are
mutually exclusive; one is always active.

* Clicking the Set Body Geometries to Convex Hulls button displays all bodies as
convex hulls, regardless of the visualization settings in the Body blocks in the model.

* Clicking the Set Body Geometries to Ellipsoids button displays all bodies as convex
hulls, regardless of the visualization settings in the Body blocks in the model.
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2 Getting Started with the Visualization Window

* Clicking the Set Body Geometries to Individual Body Settings button displays
each body according to the visualization settings in its Body block in the model. This is
the default.

Top plate Top plate
m \/
Legs Le,
gs
Leg Legs

Stewart Platform: Bodies Displayed as Convex Hulls and as Equivalent Ellipsoids

S

v‘LX v‘LX
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Adjusting the Camera View

Adjusting the Camera View

In this section...

“Setting the Background Color” on page 2-9

“Interpreting the Camera Projection, Field of View, and Viewpoint” on page 2-9
“Automatically Sizing the Camera Field of View” on page 2-11

“Automatically Setting a Camera Viewpoint” on page 2-12

“Actively Controlling the Camera Viewpoint” on page 2-13

“Camera Viewpoint and Mouse Controls” on page 2-14

Warning This content is specific to Simscape Multibody First Generation software. First-
generation features are slated to be deprecated and should be avoided.

Setting the Background Color

You must use the menu bar to change the background color of the display window within

the Simscape Multibody visualization window.

1 Open View, then select Change Background Color. A color palette opens.

2 Select a color. Click OK to implement your choice. The background color changes
immediately.

The color palette for the background is the same as the palette for custom body color. See
“Customizing Visualized Body Colors” on page 3-4.

Interpreting the Camera Projection, Field of View, and
Viewpoint
To properly interpret what you see in visualization, imagine that the display window

shows the field of view of a camera. The properties of this virtual camera determine most
of what you need to know about controlling your view of the model's machines.
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|
4 Visualized
1° | Bodies n

Pan

Camera Frame Resize

Rotate {equivalent to zoom)

Visualization Window Camera Field and Visualized Scene

Visualization and Orthographic Projection

The visualization window uses orthographic (parallel) projection to reduce a three-
dimensional scene to two dimensions on your screen. That is, parallel lines of view
representing depth converge to a point only at infinity. The window displays the scene

without finite perspective.

Camera Field of View, Viewpoint, and Frame Size

The field of view is what you see within the virtual camera frame. The virtual camera's
viewpoint is the point and direction from which it views the scene. The virtual camera

frame has a size or aperture.
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Zooming

Changing the camera frame size or aperture, then shrinking or expanding the overall size
of the machines, is the equivalent of zooming in or out. The camera cannot zoom directly,
because there is no point of convergence or perspective.

Panning

Panning changes the camera's virtual location without changing its direction of view. It
means moving the camera frame horizontally or vertically in a constant virtual plane,
maintaining the orientation of the camera frame.

Rotating

Rotating means viewing the scene from a different direction, while maintaining a constant
zoom (effective distance from the machines).

A rotation rotates about the center of the geometric bounding box containing all the
objects in the field of view. (This geometric center is unrelated to body properties, such as
Body coordinate systems or centers of gravity.) The viewpoint is moved to another point
on the virtual sphere with this same geometric center. The view direction changes to
maintain the geometric center at the center of the display window.

World Coordinate System Axes Indicate Orientation Only

The World CS axis triad always appears at the lower-left corner of the display window.

-

The directions of the axes indicate orientation only. The position of the axes does not, in
general, indicate the position of the World coordinate system (CS) origin.

Automatically Sizing the Camera Field of View

You can automatically resize the camera's field or aperture size to fit all the visualized
objects. This step is equivalent to an automatic zoom. It does not rotate the viewpoint or
pan the camera.
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2 Getting Started with the Visualization Window

To fit the field of view to size, click the Fit to View button on the toolbar. The camera
field resizes itself immediately.

Click Fitto View > Field of view resizes itself >
» Machine for model: mech_four_bar — ol x| ) Machine for model: mech_four | — ol x|
View Simulation Model Help £ View Simulation Model Help kS
H oo del »d+X » 0 0F%5 Hooosgedeld »d+X|» 0 0 %5
EERCIEIEAE EERCIERA:

N

|

PN

Automatically Setting a Camera Viewpoint

You can automatically change your viewpoint of the visualized bodies by clicking one of
the six viewpoint buttons on the toolbar. The action applies immediately.

Clicking these buttons is equivalent to setting a plane of view defined by the World CS
axes. Except for the isometric view, these predefined viewpoints always have one axis
perpendicular to the plane of view (pointing into or out of the plane of view). The
isometric view is a viewpoint direction with equal direction cosines (all ).

The default is the front view, with X pointing right, Y pointing up, and Z pointing out of

the plane of view.

Toolbar Button

Axes and Orientation of View Plane

Front View (default)

X points right - Y points up

Back View

X points left - Y points up
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Toolbar Button Axes and Orientation of View Plane

Top View X points right - Z points down

Bottom View X points right - Z points up

Left View Z points right - Y points up

Right View Z points left - Y points up

Isometric View X points down and right - Y points up - Z points down and left

Actively Controlling the Camera Viewpoint

The four selection-viewpoint toolbar control buttons enable certain interactions between
your mouse and the display window through point-and-click or point-click-hold-and-roll.

These four toolbar-menu controls are mutually exclusive; you can activate at most one of
them at a time. The default is for the Select Tool to be active.

» Enable a tool by clicking on its button.
* Disable all of them by clicking the currently active tool button.

Function Tool How to Use
Select bodies |Select Point with the mouse at a visualized body, then click on any
(default) mouse button.
Viewpoint Rotate Point with the mouse anywhere in display window. Then left-
controls Pan click, holding the mouse button, and roll mouse.
Zoom

Results of Rolling the Mouse with the Viewpoint Controls

With one of the three viewpoint control tools enabled, rolling the mouse produces one of
three possible results in the display window.

Rotate Tool

Rolling so that the arrow moves in the display window along a line, rotates the view about
that line. Rolling in a more complex figure rotates the view in a more complex way.

Pan Tool

Rolling forward, back, left, or right pans up, down, left, or right, respectively.
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2 Getting Started with the Visualization Window

Zoom Tool

Rolling forward or back zooms out or in, respectively. You zoom toward or away from the
point that you initially clicked on. Rolling left or right does nothing.

For More About the Select Tool

See “Highlighting Bodies, Body Components, and Body Blocks” on page 2-16.

Camera Viewpoint and Mouse Controls

The four selection-viewpoint tool controls and the computer mouse have a complementary
relationship to each other.

Normal Versus Dynamic Mouse Control

In normal mouse control, the left mouse button's function corresponds to the function
activated in the menus or toolbar. Depending on which function you activate from the
menu or toolbar, you can switch the left mouse button from normal to dynamic mouse
control and back. “Actively Controlling the Camera Viewpoint” on page 2-13 explains this
case.

In dynamic mouse control, the viewpoint controls are disabled from the menu or toolbar.
(Either the Select Tool is enabled, or all four selection-viewpoint controls are disabled
from the menu or toolbar.) You can still exercise the viewpoint controls with the three
mouse buttons, which are mapped one-to-one to the viewpoint controls.

Note If your mouse has fewer than three buttons, you cannot access the dynamic mouse
control functions associated with the missing button or buttons.

Normal and Dynamic Mouse Control with Left Mouse Button

The left mouse button's mapping is more complex.

Viewpoint |Active How to Use

Control

Normal: Pan |If Pan Tool is Pan field of view by clicking and holding anywhere in display

enabled from window and rolling mouse.
menu or toolbar
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Viewpoint |Active How to Use
Control
Normal: If Zoom Tool is  |Zoom field of view by clicking and holding anywhere in display
Zoom enabled from window and rolling mouse.

menu or toolbar
Dynamic: If Pan and Zoom |If Select Tool is Rotate viewpoint by clicking and holding
Rotate Tools are disabled from menu |anywhere in display window and rolling

disabled from
menu or toolbar

or toolbar:

mouse.

If Select Tool is Rotate viewpoint by clicking and holding on
enabled from menu |only background in display window and
or toolbar: rolling mouse.

Clicking on a visualized body in this case
selects the body and has no effect on
viewpoint.

Dynamic Mouse Control with Center and Right Mouse Buttons

The center and right mouse buttons' mappings are always dynamic.

Mouse |Viewpoint |Active How to Use
Button |Control
Center Dynamic: Pan |If Select Tool is Pan field of view by clicking and holding anywhere
disabled from menu |in display window and rolling mouse.
or toolbar:
If Select Tool is Pan field of view by clicking and holding on only
enabled from menu |background in display window and rolling mouse.
or toolbar: Clicking on a visualized body in this case selects
the body and has no effect on field of view.
Right Dynamic: If Select Tool is Zoom field of view by clicking and holding
Zoom disabled from menu |anywhere in display window and rolling mouse.
or toolbar:
If Select Tool is Zoom field of view by clicking and holding on only
enabled from menu |background in display window and rolling mouse.
or toolbar: Clicking on a visualized body in this case selects
the body and has no effect on field of view.
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Communicating with the Model from the Visualization
Window

2-16

In this section...

“Highlighting Bodies, Body Components, and Body Blocks” on page 2-16
“Updating the Model Diagram” on page 2-17

“Saving Visualization Settings to the Model” on page 2-18

Warning This content is specific to Simscape Multibody First Generation software. First-
generation features are slated to be deprecated and should be avoided.

Highlighting Bodies, Body Components, and Body Blocks

If you have the Select Tool enabled, clicking a body, Body coordinate system (CS), or Body
center of gravity (CG) in the Simscape Multibody visualization window causes the
following:

* The displayed body or body component changes color:

* A selected body surface or CS triad becomes yellow.
* A selected CG changes from white-black to yellow-black.

* The visualization window displays the associated Body block or Body CS name and its
path at the lower left just below the display window, in the status bar.

* The associated Body block is outlined in red in the model window.

To unhighlight, click the highlighted body again. You can select and highlight a body both
in static display and during simulation.




Communicating with the Model from the Visualization Window

Select Tool enabled Highlighted Body block

} Machine for model: mech_fceng =10/ JEng Al
Ysn Smilzien Medd He‘f: - — * |'Simulation Format |Tools Help
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Update diagram o —_—
5 i @ &
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Engine Timer
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Friction
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Engine BlockiCrank \
Body block paﬂ'l\ and name \Selected body I
Ready [100% [ |odeds 4

Simscape Multibody Visualization Window with Highlighted Body and Body Block (Four-
Cylinder Engine)

Enabling and Disabling Highlighting

You can enable or disable the highlighting of model Body blocks from the Model menu
item Enable Model Highlighting. The default is enabled.

Whether model highlighting is enabled or disabled, clicking a body or body component in

the window always highlights it. If you disable model highlighting, the associated Body
block is not highlighted when you click the displayed body or body component.

Updating the Model Diagram

You can update your Simulink model diagram from the model toolbar or Edit menu, or by
pressing Ctrl+D from the keyboard.

You can also update it by clicking the Update Simulink Diagram button in the
visualization window toolbar.
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Saving Visualization Settings to the Model

As you work with the visualization settings, you might want to save the setting changes
that you make.

* Changes you make to the visualization settings apply only to the display while the
window is open. If you do nothing else and close the window, then upon reopening the
visualization window, the display will revert to whatever model requires for
visualization settings. See “Hierarchy of Body, Machine, and Model Visualization
Settings” on page 1-10.

+ Ifyou want to save the display setting changes you made from the window controls
before closing the window, you must save them to the model. Click the Save
Visualization Settings to Model button on the visualization window toolbar. A
warning dialog appears, asking if you want to save the model itself.

+ Ifyou want to save these display setting changes before closing the model, you must
save or resave the model itself. Click the Save button in the model toolbar.



Communicating with the Model from the Visualization Window

Save Visualization Seftings to Model

) Machine for model: mech_spen - ol x|
View Simulaton Model Help N
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Display all bodies as ellipsoids (nondefault)
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Caution If the changes to the display settings include changing the displayed body
geometries, the saved visualization settings will make the visualization window display
whatever the setting requires (all convex hulls, all equivalent ellipsoids, or individual
body geometries). But the saved visualization display settings do not change the
visualization settings at the model, machine, or Body block level in the model.
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Controlling Simulation from the Visualization Window

2-20

In this section...

“Starting, Pausing, and Stopping the Simulation” on page 2-20
“Timing the Simulation” on page 2-20

Warning This content is specific to Simscape Multibody First Generation software. First-
generation features are slated to be deprecated and should be avoided.

Starting, Pausing, and Stopping the Simulation

You can control a simulation from the Simscape Multibody visualization window with the
pair of simulation control buttons. The pair takes two different appearances, depending
on whether the simulation is running.

With Simulation Stopped

From left to right, the buttons are Start and Stop, with Stop disabled:
With Simulation Running

From left to right, the buttons are Pause and Stop: o -

* Ifyou pause a running simulation, restarting it begins the simulation at the simulated
time when it was stopped.

» If you stop a running simulation, restarting it begins the simulation at a simulated time
of zero.

Timing the Simulation

Once you start the simulation, you can track the simulation time at the lower right of the
visualization window, in the status bar; if the simulation time display is active.



Controlling Simulation from the Visualization Window

) Machine for model: mech_robot _ ol x|
View Simulation Model Help
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Simulation Time Display (Robot Arm Simulation with Visualized Body CSs and
CGs Deactivated)

Activating and Deactivating the Simulation Time Display

You can activate or deactivate the simulation time display using the Display Simulation
Time button on the toolbar. The default is active.
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Controlling Animation

2-22

In this section...

“About Animation” on page 2-22

“How Animation Works” on page 2-22

“Automatically Adapting the Camera View to the Displayed Motion” on page 2-23
“Changing How the Animation Is Updated” on page 2-24

“Speeding Up the Animation in Real Time” on page 2-25

Warning This content is specific to Simscape Multibody First Generation software. First-
generation features are slated to be deprecated and should be avoided.

About Animation

When you start a simulation with visualization and animation enabled, the Simscape
Multibody visualization window displays the body motion. This section shows how you can
control the animation.

How Animation Works

The visualization window displays the animated bodies in whatever camera view you
previously set before starting simulation. By default, the camera remains at rest in World.

The animation that you see in the display window is the result of three distinct processes

operating in parallel.

* Simulink® updates the model simulation at every simulation time step.

* Simulink updates the model outputs at every output sample time step.

* During animation, the visualization window updates the display of the bodies at every
visualization sample time step.

Each updated, displayed simulation scene is also called a frame.

By default, the output sample times are every major time step, and the visualization
sample times are the output sample times. But, within limits, you can change the
relationships among these time steps.




Controlling Animation

Caution Because visualization needs the model outputs to update the animation, the
visualization sample time should be equal to or longer than the model output sample time.
If the visualization sample time is shorter, the displayed animation is updated at the
model output sample times.

Automatically Adapting the Camera View to the Displayed
Motion

As the bodies move in the animation, the camera view you set for the static case before
simulation might not encompass their full range of motion. Or the bodies might move out
of the field of view altogether.

You can require the display window to adapt the field of view dynamically to the
animation with the Enable Automatic Expanding Fit and Enable Automatic Tight Fit
buttons on the toolbar. These buttons are mutually exclusive. The default for both is
disabled.

Allowing the Field of View to Expand with the Moving Bodies

If the animated bodies tend to move out of the field of view once, repeatedly, or
continually, click the Enable Automatic Expanding Fit button. The field of view will
then expand as necessary to encompass the geometric bounding box of all the bodies, as
visualized. The camera remains at rest in World.

Keeping the Field of View Limited to the Moving Bodies

If you want your field of view to encompass just the moving bodies and track them as they
move, click the Enable Automatic Tight Fit button. The center of the field of view will
remain fixed to the center of the geometric bounding box of all the bodies, as visualized.
The camera is no longer at rest in World, but continually zooms and pans to track this
geometric center.

Caution With automatic tight fit enabled, the observer's reference frame is no longer at
rest in World and, in general, is noninertial. The motion of bodies that you see is not that
seen by an observer in World.

This automatic tight fit can create the illusion that the bodies as a whole are not moving.
Disable the automatic tight fit to check if this is the case.
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Changing How the Animation Is Updated

You might find it convenient to change how quickly the animation in the display window
responds to changes in the simulation, especially if the animation is going by too fast in
real (clock) time.

You can change most of these controls by going to the Simulation menu in the menu bar,
then to Control Animation Speed. The Animation Speed Control Parameters dialog box
opens. You can apply any changes and close the dialog by clicking OK.

Delaying the Simulation at Every Display Update

At each update of the animation display, the Simscape Multibody simulation is delayed for
some (simulated) time to allow you to follow the motion. You can change this delay time in
the Animation Speed Control Parameters dialog. Enter a nonnegative time (in
milliseconds) in the Delay per frame field. The default is 3 (ms).

Changing the Visualization Sample Time

You can break the default connection between visualization and model output sample
times in the Animation Speed Control Parameters dialog as well. Enter a specified
visualization sample time (in seconds) in the Visualization sample time field. This time
is simulated (not real) time.

The default is 0 (s). This is smaller than any positive model output sample time, and the
visualization is effectively updated at the output sample times.

Require the visualization explicitly to inherit the model output sample time by entering
-1.

Changing the Model Output Sample Time

You can also change the effective visualization sampling rate by changing the model
output sample time in the model's Configuration Parameters dialog and leaving the
visualization sample time to be whatever the model output sample time is. This time is
simulated (not real) time.

1 Open the Configuration Parameters dialog from the Simulation menu of your model
window.

2  On the Data Import/Export node, under Additional parameters area, change the
Output options pull-down menu entry to Produce specified output only.



Controlling Animation

3 Use the Output times field on the right to specify explicitly how often Simulink
should capture the simulation output. In this field, enter a vector of sample times.
The sample time range must be the same as or lie within the Start time and Stop
time range of the Simulation time area in the Solver node of Configuration
Parameters.

If you want a uniform output sampling, use the linspace command to specify the time
range and number of sample points:

linspace(start-time, end-time, number-of-points)
For example, to sample 200 points from 0 to 10 seconds:

Open Configuration Parameters from the Simulation menu.

In the Data Import/Export pane, under Additional parameters, select Output
options. Change the pull-down menu to Produce specified output only.

3 Enter linspace(0,10,200) in the Output times field. Click Apply or OK.

Tip This approach does change two distinct model features at once. Changing the
visualization sample time by itself (preceding) has the advantage of letting you specify the
model output sample time separately.

See the Simulink documentation for more about model output sample time.

Speeding Up the Animation in Real Time

As the simulation animates the bodies' motions, it might slow down. You can make the
animation computationally less demanding with these measures.

Skipping Frames

By default, the animation displays every updated frame. But you can skip a fixed number
of frames between displayed frames.

From the Simulation menu, select Control Animation Speed. In the Animation Speed
Control Parameters dialog, change the Number of skipped frames per update field to
a positive integer to specify this number. The default is 0.

Using fewer sample points leads to a more disjointed animation, but a faster simulation
and a smaller recorded animation file.
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Turning Off Visualization Features

You can speed up the animation if you turn off one or both of these symbols:

* Body centers of gravity (CGs)
* Body coordinate systems (CSs)

The preceding section, “Controlling Body and Body Component Display” on page 2-6,
explains how to control their display.

You can also speed up the animation by turning off the simulation time display. See the
preceding section, “Controlling Simulation from the Visualization Window” on page 2-20.

2-26



Recording Animation

Recording Animation

In this section...

“About Recording” on page 2-27

“How Recording Works” on page 2-27

“Recording Animations” on page 2-27

“Compressing Animation Recordings” on page 2-29
“Controlling the Size of the Recorded Animation” on page 2-30

“Playing Recordings of Animation” on page 2-30

Warning This content is specific to Simscape Multibody First Generation software. First-
generation features are slated to be deprecated and should be avoided.

About Recording
As the Simscape Multibody visualization window displays the body motion, you can
capture what you see as a recording and save it. This section explains how to record

animations. See the preceding section, “Controlling Animation” on page 2-22, for more
about animation.

How Recording Works

If you record an animation, the recording captures each updated, displayed simulation
scene as a frame.

Whatever you see in the animated display window, is what the recording captures, as
closely as it can within the limitations of the format.

Recording Animations

When you record an animation from the window, it is stored as a file on your system in
Audio Video Interleave (AVI) format.
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Caution Recording an animation overwrites any existing file with the same name as the
AVI file in the same folder. The AVI file write fails if a file of the same name that is locked
by another application exists in the same folder.

Activating and Controlling Animation Recording

* You can activate animation recording by clicking the Store Animation in AVI File
button on the toolbar. The default is deactivated.
If you activate, the AVI File Location file browser opens, as discussed next.

* You control recording settings using the Simulation menu.

Specifying the Name and folder of the Animation File

You can specify a location and name for your AVI file recording by selecting Choose AVI
File Location from the Simulation menu. If you activate recording, an AVI File Location
file browser opens and requires you to select a location and specify an AVI name. The
default AVI name for a model called modelname.mdl is modelname. avi, but you can
change this default name. Click Save to complete the AVI file specification.

When you activate recording, this AVI file name appears in the bottom middle of the full
visualization window, below the display, in the status bar.

If you cancel the file browser, the recording is canceled as well.



Recording Animation
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How MATLAB Records the Animation

The simulation first records a MATLAB movie by capturing the display at every
visualization sample time step. Then, in the termination phase of your simulation, it
converts this movie to AVI format and stores it in the AVI file. A small AVI Conversion
window opens to indicate that conversion and storage are complete and to display the
path of the AVI file. Click OK to close this prompt.

Compressing Animation Recordings

You can reduce the size of your AVI file by compressing it. Select Compress AVI File to
activate this feature. The default is active.
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Support Restrictions for Recording Compression

AVI compression is available only on the Windows® platform. MATLAB uses the Indeo 5
compression algorithm. You must have the corresponding video codec installed to

* Compress an animation while recording.
* Decompress and play back a compressed animation recording.

Check your operating system configuration for installed video codecs.

Caution You must have the Indeo 5 video codec installed to compress an animation
recording. If you do not have this codec installed, animation and recording proceed, but
with compression deactivated.

Controlling the Size of the Recorded Animation

Any technique that reduces the number of visualization samplings and updates reduces
the total stream of animated frames and the size of the recorded file. See “Controlling
Animation” on page 2-22.

Tip If MATLAB runs out of memory while recording an animation, you will receive a
warning. The simulation continues until completion, but recording is truncated at the
simulation time when memory was exhausted.

Use one of the techniques discussed to reduce the total stream of animated frames and
attempt the recording again. The simplest technique is to skip frames.

Playing Recordings of Animation

You need an AVI-compatible video player to view the recorded file. You can use the
internal MATLAB movie viewer or an external video player.

Caution You must have the Indeo 5 video codec installed to decompress and play back a
compressed animation recording.
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Matching Playback Speed to Simulation Speed

Your computer will play back an AVI animation recording at 15 frames per second of real
(clock) time, regardless of the simulation speed or visualization sample time during
recording.

To guarantee that the animation playback show the simulation in real (clock) time, before
recording, set:

* The model output sample time to be 1/15th of a second.

* The visualization sample time to be equal to or less than the model output sample
time.

See “Changing How the Animation Is Updated” on page 2-24 for more about sample
times.
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Simscape Multibody Visualization Menus and Their
Controls

In this section...

“About the Visualization Window Menus” on page 2-32
“View Menu” on page 2-33

“Simulation Menu” on page 2-34

“Model Menu” on page 2-37

“Help Menu” on page 2-38

Warning This content is specific to Simscape Multibody First Generation software. First-
generation features are slated to be deprecated and should be avoided.

About the Visualization Window Menus

The menus of the visualization window group similar functions and contain all
visualization functions.

Some menu items have a default setting. Others do not, as indicated by a “—” entry for
the default in the menu tables following.

Menu Group |Feature or Function

View Change camera viewpoint or frame; manipulate camera view; change
background

Simulation Control simulation; change dynamic camera response to animation;
record animations

Model Change display of body components and geometries; change common

visualization-model features

Help Get visualization help

Persistent Settings Versus Immediate Action

In most situations, all menu items are enabled in the sense that you can activate it. In
some conditions, a menu item can be disabled, and you cannot activate it.
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Some menu items control a persistent setting and switch between active and not active;
for example, Enable Model Highlighting. By selecting the item, you either activate it,
and a check mark appears; or you deactivate it, and the check mark disappears.

Other menu items, when you select them, instead trigger an immediate action, for
example, Simulation > Start.

View Menu

This menu allows you to control two distinct visualization features, the camera viewpoint
and frame and the background color.

View Simulation Model Help

Orientation Fromt
Fit to View Back
v Select Top
Rotate Bottom
Pan Left
Zoom Right
Change Background Color ~ [somefric
Menu ltem Function Default
Orientation submenu: Set camera viewpoint. Front

Front, Back, Top,
Bottom, Left, Right,
Isometric

One choice is always active, and the choices
are mutually exclusive.

Fit to View

Resize camera field to closely fit the bodies as
viewed.
Applies immediately.

Current Tool:

Enable mouse point-and-click tool.
The choices are mutually exclusive, and can
all be unselected (deactivated).

Select

Select objects in the display window.

Selected
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Menu Item Function Default
Rotate Rotate camera viewpoint. Unselected
Pan Pan camera field laterally and vertically. Unselected
Zoom Zoom in and out of camera field. Unselected

Change Background
Color

color.

Open color palette to choose background

Simulation Menu

This menu allows you to control the simulation, the dynamic camera field, and the
recording of the animation.

Start
Stop

Simulation Model Help

Crl+T

Enzable Automatic Tight Fit
Enable Automatic Expanding Fit

Store in AVI File
Chioose AVI File Location ...
v Compreass AVI File

Control Animation Speed
v Display Simulation Time
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Menu Item Function Default
Simulation |Start Start simulation. Appears and enabled only |—

start, when simulation is stopped.

pause, and Applies immediately. Keyboard equivalent is

stop Ctrl+T.
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Menu Item

Function Default
Pause Pause simulation. Appears and enabled only |—

when simulation is running.

Applies immediately.
Stop Stop simulation. Enabled only when —

simulation is running.
Applies immediately. Keyboard equivalent is
Ctrl+T.

Dynamic camera field

Enable adaptive dynamic camera field during
animation.
The choices are mutually exclusive, and can

Fixed camera field,
viewpoint, and zoom;
camera at rest in

all be unselected (deactivated). World.
Enable Enable automatic resizing and zooming of Unselected
Automatic camera field to keep moving bodies in fit-to-
Tight Fit view field at all simulation times.

Virtual camera moves with overall model

motion with respect to World.
Enable Enable automatic expansion of camera field |Unselected
Automatic to keep moving bodies in field at all
Expanding Fit |simulation times.

Virtual camera remains at rest with respect

to World.

Store in AVI File Record and save animation in AVI file. Unselected

Choose AVI File Location

Choose nondefault location for AVI file.

Default location for
saved AVI file is
current working
MATLAB folder.

Compress AVI File

Apply compression to saved AVI recording of
animation.

Selected

Control Animation Speed

Opens Animation speed control parameters
dialog.
Applies immediately.

Visualization 0
sample time (s)

Delay per frame |3
(ms)
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Menu Item Function Default

Number of
skipped frames
per update

Display Simulation Time |Show simulation time in lower-right corner |Selected
of full window.

Start-Pause-Stop Menu During Simulation

During simulation, the start-pause-stop part of the Simulation menu looks like this:

Simulation Model Help

Palse
Stop Crl+T

Animation Speed Control Parameters Dialog

The Control Animation Speed menu item opens the Animation Speed Control
Parameters dialog:

) AnimationagMslFq
Vizualization =ample time (2) (-1 to inherit)

P

Delay per frame (ms}

Mumber of =kipped frames per update

P

oK Cancel

See “Controlling Animation” on page 2-22.
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Model Menu

This menu allows you to control the display of body geometries and body components, as
well as communicate from the visualization window to the model.

\Model Help e l
: Body Geometries Convex Hulls
- v Centers of Gravity (CGs) Ellipsoids
v Coordinate Systems (CSs) v Individual Body Settings
Update Simulirk Diagram Ctrl+D

v Enable Model Highlighting
Save Visualization Settings to Model Crl+S

Menu ltem Function Default
Body Geometries Set geometries of visualized bodies. —
submenu: One choice is always active, and the choices are
mutually exclusive.
Convex Hulls |Visualize all bodies in window as convex hulls. Unselected
Ellipsoids Visualize all bodies in window as equivalent ellipsoids. |Unselected
Individual Body |Visualize all bodies in window according to their Selected
Settings respective Body block visualization settings.
Centers of Gravity Display centers of gravity of all visualized bodies. Selected
(CGs)
Coordinate Systems |Display all Body coordinate systems attached to all Selected
(CSs) visualized bodies.
Update Simulink Apply Update Diagram command to model. Applies —
Diagram immediately.
Keyboard equivalent is Ctrl+D. Model equivalent is Edit
> Update Diagram.
Enable Model Enable automatic Body block highlighting when Selected
Highlighting visualized body is selected in display window.
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Menu Item Function Default

Save Visualization Save current state of visualization window controls to —

Settings to Model model. Applies immediately.
(You need to save the model itself to save the settings

permanently.)

Help Menu

This menu allows you to get online help for the visualization window. Selecting Open
Visualization Help immediately opens the Help browser to the Simscape Multibody

visualization documentation.

Help

Open Visualization Help
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Customizing Visualization and
Animation

You can customize the colors and geometries of visualized bodies in the Simscape
Multibody visualization window. Choice of colors is intrinsic to visualization. Specifying a
custom body geometry requires an external graphics file for each customized body.

As an alternative to the visualization window, you can also visualize your mechanical
system with virtual reality.

“About Custom Simscape Multibody Visualization” on page 3-2
“Customizing Visualized Body Colors” on page 3-4
“Customizing Visualized Body Geometries” on page 3-7
“Visualizing with a Virtual Reality Client” on page 3-12
“Reference” on page 3-26
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About Custom Simscape Multibody Visualization

3-2

In this section...

“Customizing Visualization Settings” on page 3-2
“Creating an External Virtual Reality Client” on page 3-3

Warning This content is specific to Simscape Multibody First Generation software. First-
generation features are slated to be deprecated and should be avoided.

Customizing Visualization Settings

You can customize the way that Simscape Multibody visualization displays bodies, in
terms of their colors and geometry. The geometry is composed of the body's size and
shape.

* You can adjust the body color on a model- or machine-wide basis, or on an individual
body basis.

* With an external graphics file referenced by a Body block, the visualization window
can visualize the body with whatever shape the graphics file specifies.

For more information about starting visualization for a Simscape Multibody model, review
the section Starting Visualization on page 1-2.

Model- and Machine-Wide Body Color and Geometry Controls

The model-machine-body hierarchy controls the model- and machine-default body colors
and geometries. See “Hierarchy of Body, Machine, and Model Visualization Settings” on
page 1-10.

To control visualization settings for an entire model or machine, you need to revisit the
following two dialogs. These controls allow you to set a single default color and a single
default standard geometry for all the bodies in a model or in a machine.

* To set a model-wide default body color and geometry, use the Visualization area of
the Simscape Multibody 1G node of the Configuration Parameters dialog.
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— Visualization

™ Display machines after updating diagram
[~ show animation during simulation

[~ Show only port coordinate systems

Default body color (RGE): {[100]

Default body geometries: ICnnvex hull from body C5 locations

I

To set machine-wide default body color and geometry, use the Visualization tab of

that machine's Machine Environment block dialog.

Parameters I Constraints I Linearization Visualization |

To enable visualization and animation of connected machine, select 'Visualize
machine.' Visualization and/or animation must also be enabled in the SimMechanics

node of the Configuration Parameters dialog.

v visualize machine

Default body geometries: IUse model default body geometries

Body color selection mode: IUse model default

=
=

Default body color (RGE):  [[10 0]

Creating an External Virtual Reality Client

You can bypass standard Simscape Multibody visualization by creating a virtual reality
world of your own design to visualize your model's bodies. You can then build a custom
interface from your model to the virtual world and animate its virtual bodies. See the final
section, “Visualizing with a Virtual Reality Client” on page 3-12.
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Customizing Visualized Body Colors

3-4

In this section...

“Choosing Custom Body Colors” on page 3-4

“Switching Between Default and Custom Body Colors” on page 3-4

Warning This content is specific to Simscape Multibody First Generation software. First-
generation features are slated to be deprecated and should be avoided.

Choosing Custom Body Colors

Simscape Multibody visualization has two formats for specifying a color.

MATLAB ColorSpec Vector

You specify colors by RGB values according to the MATLAB Graphics ColorSpec for

* An entire model, in the Visualization area of the Simscape Multibody 1G node of
the Configuration Parameters dialog.

* An entire machine, in the Visualization tab of that machine's Machine Environment
block dialog.

The RGB (red-green-blue) triple of values is a vector [r g b], with each value
separately satisfying 0 < r, g, b = 1.

* Red, green, and blueare [1 0 0], [0 1 0], and [0 O 1], respectively.
* Black and white are [0 0 0] and [1 1 1], respectively.
* Other valid triples specify nonfundamental colors.

Color Palette Interface

You specify colors for individual bodies by visual inspection in the color palette in their
respective Body dialogs.

Switching Between Default and Custom Body Colors

The Simscape Multibody visualization initial default color for visualized bodies is red
(RGBof [1 0 0]).
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Changing the Default Color for All Bodies in a Model

You can change the initial default to a different default color for all visualized bodies in a
model.

1 Open the Configuration Parameters dialog, then go to the Simscape Multibody 1G
node.

2 In the Visualization area, change the Default body color RGB vector to a different,
valid vector of values.

3 Click Apply or OK.

Note You can override the model-wide default body color, both for a whole machine and
for individual bodies.

Changing the Default Color for All Bodies in a Machine

The initial default is for a machine to inherit its model-wide body color. You can override
the initial default by specifying a different machine-wide default color for all the bodies in
one machine in your model.

1 Open that machine's Machine Environment block dialog and click its Visualization
tab.

2 In the Body color selection mode pull-down menu, choose Specify. The Default
body color field becomes active.

Change the RGB vector to a different, valid vector of values.
Click Apply or OK.

Note You can override the machine-wide default body color for any individual body
within the machine.

Changing the Color of an Individual Body

The initial default is for a Body to inherit its machine-wide body color. You can override
the initial default by specifying a different color for an individual visualized body.

1 Open the Body block dialog and click its Visualization tab.
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2 In the Body color pull-down menu, choose Use color palette. The color palette
button appears.

3 Click the color palette button. The color palette opens.
Select a color from the palette and click OK.
5 To save the changes to the Body block and the model, click OK on the Body dialog.

gl Color
- bl —
o HOOOONEEMN
o MEEEEONEN
Posiﬁon' Orientation \ﬂsualizat‘onl // EEEEEEEDRE
Body geometry: |Use machine default body geometry ;J—/ OO0 o0OoOm | O™
Body color: IUsecoIorpaIetbe 'I &f EEERENEN N N N
] \‘K HREREREN B N W
~ NN N N N
e D000 EEEN
I D00 0DEEEN

\“‘“‘\ More Colors... |

Color palette button ~

™~ OK | Cancel |

Body Dialog: Visualization Tab and Body Color Palette

3-6




Customizing Visualized Body Geometries

Customizing Visualized Body Geometries

In this section...

“Choosing Custom Body Geometries” on page 3-7

“Switching Between Standard Body Geometries” on page 3-7

“About STL Body Graphics Files” on page 3-8

“Obtaining STL Body Graphics Files for Custom Body Geometries” on page 3-9

“Switching Between Standard and Custom Body Geometries” on page 3-10

Warning This content is specific to Simscape Multibody First Generation software. First-
generation features are slated to be deprecated and should be avoided.

Choosing Custom Body Geometries

Using body mass and geometry information from the Body block alone, the Simscape
Multibody visualization window allows you two choices of standard body geometry, the
convex hull and the equivalent ellipsoid.

You also have the choice of a nonstandard body geometry specified by an external

graphics file.

Switching Between Standard Body Geometries

The Simscape Multibody initial default body geometry for visualized bodies is the convex
hull.

Changing the Default Geometry for All Bodies in a Model

You can change the initial default of convex hulls to equivalent ellipsoids for all visualized
bodies in a model.

1 Open the Configuration Parameters dialog, then go to the Simscape Multibody 1G
node.

2 Inthe Visualization area, select Equivalent ellipsoid from mass
properties from the Default body geometries pull-down menu.
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3 Click Apply or OK.

Note You can override the model-wide default body geometry, both for a whole machine
and for individual bodies.

Changing the Default Geometry for All Bodies in a Machine

The initial default is for a machine to inherit its model-wide body geometry. You can
override the initial default by specifying a different machine-wide default geometry for all
the bodies in one machine in your model.

1  Open that machine's Machine Environment block dialog and click its Visualization
tab.

2 In the Default body geometries pull-down menu, choose a new machine-wide
default, either Convex hull from body CS locations or Equivalent
ellipsoid from mass properties.

3  Click Apply or OK.

Note You can override the machine-wide default body geometry for any individual body
within the machine.

Changing the Geometry of an Individual Body

The initial default is for a Body to inherit its machine-wide body geometry. You can
override the initial default by specifying a different geometry for an individual visualized
body.

Open the Body block dialog and click its Visualization tab.

In the Body geometry pull-down menu, choose either Convex hull from body
CS locations or Equivalent ellipsoid from mass properties.

3 Click Apply or OK.

About STL Body Graphics Files

Simscape Multibody visualization supports the specification of body geometry (size and
shape) with stereolithographic (STL) files in either ASCII or binary format. Each body
with a custom geometry requires one STL file to provide this geometry.
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Stereolithography specifies the three-dimensional surface geometry of a body by linked
triangles whose edges and vertices are oriented by the right-hand rule. The orientation
defines an “outside” and an “inside” of the surface. The edges and vertices of the
elementary triangles join to form a continuous surface. A closed surface of such linked
triangles approximates a body's smooth curved surface.

Edge and
vertex joins
Qutside

&

Elementary
oriented
triangles

Stereolithographic triangles have some similarity to convex hulls. But convex hulls are
directly and solely determined by the origins of the Body coordinate systems. Convex
hulls are not necessarily made up of triangles. An STL file can specify an arbitrary
number of elementary oriented triangles with vertices at arbitrary points in space. These
vertices have no necessary connection to the Body coordinate systems.

Obtaining STL Body Graphics Files for Custom Body
Geometries

You can obtain STL body geometry files from a number of sources.

* You can write a new STL file as a text file, following the STL standard.

* You can generate an STL file from many mechanical design applications, such as
computer-aided design (CAD) platforms.

* The Simscape Multibody Link utility exports an STL file for each part in a CAD
assembly. The CAD platform must be linked to the Simscape Multibody Link utility.
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* You can reuse existing STL files, possibly with your own modifications. You can obtain
such STL files from Simscape Multibody examples, other applications, and CAD-
oriented Web sites.

Note Refer to the Simscape Multibody Link documentation for more information about
exported STL files.

Switching Between Standard and Custom Body Geometries
You can switch from the standard body geometries to a custom body geometry by
changing the Body block to reference an external body geometry file. This custom body
geometry specification overrides the model- and machine-wide defaults, but only for this
body.

Requirements for External Body Geometry Files

The external body geometry file must be in STL format.

Caution In order for custom visualization to work, this STL file must be either:

* On your MATLAB path.
* In your MATLAB present working folder.
* Specified with complete path in the Body dialog.

Otherwise, visualization reverts to the default body geometry.

Specifying an External Body Geometry File

Open the Body block dialog and click its Visualization tab.
2 In the Body geometry pull-down menu, choose External graphics file.

The External graphics file field and Attached to Body CS pull-menu appear.
3 Enter the graphics file name and any necessary path in the field.

From the pull-down menu, choose which Body CS to attach the graphics to. (The
Body CSs are listed in the Body's Position tab.) This Body CS serves as the reference
for the origin, coordinate axes, and units of the body geometry.
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5 Click Apply or OK.

Position I Orientation Visualization |

Body geometry: IExternaI graphics file _} Speciry external body geomeﬁy
Body color: IUse machine default LI
External graphics file: Ibodyjeomeh’y.sﬁ _i Specify external geometry file
Attached to Body CS: [CS1 =1 Specify Body CS for

body geometry reference

Body Dialog: Visualization Tab and External Body Geometry Reference

Attached Body Coordinate System as Geometric Reference for the Body
Geometry File

The external graphics file has no intrinsic geometric origin, orientation, or units. The
attached Body CS provides an origin, axis directions (orientation), and units of length to
interpret the geometric information specified by the external graphics file.

Tip If you need a body geometry origin, orientation, or system of units that is not
represented in your current list of Body coordinate systems, create a new Body CS in the
Position tab with the geometric features you want. You can make this Body CS invisible
on the Body block if you wish.
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Visualizing with a Virtual Reality Client
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In this section...

“About Virtual Worlds for Machines and Models” on page 3-12
“Creating Virtual Worlds for Simscape Multibody Models” on page 3-12
“Interfacing Simscape Multibody Models with Virtual Worlds” on page 3-14

“Creating and Interfacing a Model Virtual World” on page 3-16

Warning This content is specific to Simscape Multibody First Generation software. First-
generation features are slated to be deprecated and should be avoided.

About Virtual Worlds for Machines and Models

You can bypass Simscape Multibody visualization and create a mechanical animation in a
virtual world of your own design. You create a virtual world, populate it with bodies
represented as virtual objects using Virtual Reality Modeling Language (VRML), then
interface the virtual world with your Simscape Multibody model. Creating your own
virtual animation requires a new or existing virtual world for your model and an interface
between them.

This section explains how to couple a separately created virtual world with a Simscape
Multibody model.

Building Virtual Worlds This section assumes that Simulink 3D Animation software is
installed on your system and that you are familiar with it and with creating virtual worlds.
Refer to the Simulink 3D Animation documentation for full details on installing and using
this toolbox.

We recommend you allocate generous central processor power, graphics card speed, and
memory for virtual reality visualization, especially for animation.

Creating Virtual Worlds for Simscape Multibody Models

The Simulink 3D Animation documentation and VRML books [1] explain how to create
virtual objects and assemble them into virtual worlds. A displayed virtual world is called a


https://www.mathworks.com/products/3d-animation.html

Visualizing with a Virtual Reality Client

virtual scene. The best way to become comfortable moving around in a virtual world is to
practice with a variety of movement modes and viewpoints. This section highlights the
requirements to make a virtual world usable as a visualization for a Simscape Multibody
model.

Editing Virtual Worlds and VRML Files

As you create a virtual world populated by virtual bodies, you must create each
component body, then plan and implement the geometry of the bodies' initial state. Use a
VRML authoring tool that can read VRML as a native format to create and edit virtual
reality .wrl files. Simulink 3D Animation software includes a VRML authoring tool called
V-Realm Builder®. If you are familiar with native VRML source code, you can use a plain
text editor or the MATLAB editor to edit the files.

Representing Bodies as Virtual Objects

You represent each body by a virtual object encoded in a .wrl file. You also create a
master .wrl file to represent the virtual world that refers to body .wrl files, placing and
orienting these bodies in the larger scene. You can define a body's position and
orientation with respect to:

» The overall virtual world, corresponding to the Simscape Multibody coordinate system
World.

* Another body in the machine, corresponding to Simscape Multibody Body coordinate
systems.

You can nest body references to other bodies in VRML hierarchies, but you must define at
least one body's position and orientation with respect to the overall virtual world. Place
and orient the bodies in their initial states, corresponding with the initial state of the
Simscape Multibody simulation.

Each body's .wrl file contains a hierarchical tree starting with the Transform node.
Among Transform's fields must be translation and rotation fields to specify the body's
position and orientation in space. If a body is nested below another body, its position and
orientation are defined with respect to the next body up the hierarchy.

Creating your own virtual world gives you great flexibility in representing your machine:

* You can display bodies in as much or as little detail as you want, with shapes, colors,
textures, etc., of your own choosing.

* You can include or omit bodies as desired.
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* You can create a computer-aided design (CAD) assembly of your machine and export it
into VRML files.

* Ifyou only translate a body, you can omit the rotation field from its Transform node.
+ If you only rotate a body, you can omit the translation field from its Transform node.

Interfacing Simscape Multibody Models with Virtual Worlds

To animate a body, you need to measure its motion in your Simscape Multibody simulation
and export that information to the virtual world. This requires connecting Body Sensor
blocks to the Bodies you want to animate in your model, then creating an interface that
animates the virtual bodies with the body sensor motion signals. “Interfacing the Model
and the Virtual World” on page 3-19 applies these steps to the mech conveyor vr
example.

Adding and Configuring Body Sensors

Connect the Body Sensors to Body coordinate systems (CSs) on the bodies whose motions
you want to animate. The Body block reference discusses how to create and configure
Body CSs. You need to take these extra steps to export the signals of a body sensor to
your virtual world:

1 Make sure the Body Sensor's Body CS reference origin and orientation follow the
body's defining VRML hierarchy.

Example: You define a new Body CS on a body to connect the Body Sensor. If you
defined the VRML body's position with respect to the center of gravity (CG) of a
second, neighboring body in your VRML files, you should set the Translated from
origin of field of the new Body CS to the origin of the CG CS of the second body.

2 In the Body Sensor dialog, select the [x; y; z] Position check box if you want to
animate the body's translational motion.

Select the [3 x 3] Rotation matrix check box if you want to animate the body's
rotational motion.

3 Choose the coordinate system in which the body motions are measured in the With
respect to coordinate system pull-down menu. You can pick Absolute (World)
or Local (Body CS). This coordinate system should be the same as the coordinate
system used to define the body's position and orientation in the VRML files.

A Simulink output port > appears on the block for each of the motion signals. The
translational signal is a 3-vector of spatial coordinates, (x, y, z). The rotational signal is a
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9-vector, column-wise representation of the 3-by-3 orthogonal rotation matrix R, (R;;, Ry,
R31, Ry, ...).

Animating the Virtual World Bodies

Animating the virtual bodies requires interfacing the body sensor signals in the Simscape
Multibody model with the VRML translation and/or rotation fields in the .wr1 files. You
accomplish this with the VR Sink block, which you can find in the Simulink 3D Animation
block library.

Enter vrlib at the command line. Drag a copy of the VR Sink block into your model.

2 Open the VR Sink dialog box. (The figure “Conveyor Loader Model: VR Sink Dialog
Box” on page 3-24 displays an example of the dialog.)

3 In the Source file field in the World properties area, enter the name of the VRML
file that represents your model's virtual world. This is the file that refers to the
other .wrl files representing the component bodies of your machine. If the virtual
world VRML file is not in the same folder as your model, enter the file's path relative
to the model.

Click Apply. In the VRML Tree window, the node list of the virtual world .wr1 file
appears.

4 Expand the tree of each component body in the list to view that body's check box list.
Select the rotation and/or translation check boxes as needed for each body. A
Simulink input port > appears on the block icon for each of these selected check
boxes.

The ports are labeled node.field. The node is the name for the body. The field is
named either rotation or translation.

Converting Body Sensor Signals into VRML Format

You are now ready to connect the Body Sensor output signals to the VR Sink block. But
you might need to modify those signals for valid use in VRML.

* You can connect the translational motion signal line directly from the output port of
the Body Sensor to the node.translation input port on the VR Sink. The VRML
node tree directly accepts translation motion as a 3-vector signal of rectangular
coordinates (x,},2).

Make sure that the translational motion signal refers to the same coordinate system
used to define the body's position in the VRML files.
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You cannot directly connect the rotational motion signal line to the VR Sink. The Body
Sensor output represents orientation with a 3-by-3 rotation matrix R, while VRML
accepts orientation represented as the axis-angle 4-vector form [ n 6 ], where n = (n,,
ny, n,) is a 3-vector representing the rotation axis and 6 is the rotation angle.

Open the Simscape Multibody Utilities library. For each rotational motion signal, drag
a RotationMatrix2VR block into your model. Connect the rotation signal from the Body
Sensor block to the RotationMatrix2VR block. Then connect the latter block to the
corresponding node. rotation input port on VR Sink for that body. This block
converts the 3-by-3 R matrix signal into the 4-vector VRML form.

Close the VR Sink block dialog. Your Simscape Multibody model now animates the virtual
world.

Creating and Interfacing a Model Virtual World

The model mech _conveyor vris a modified version of the original conveyor model
mech_conveyor.

Viewing the Custom External VRML Files

The mech conveyor vr model comes with external VRML files containing static
geometries of the machine parts in their initial positions. This example uses the V-Realm
Builder editor to view the files.

1

In the matlabroot\toolbox\physmod\mech\mechdemos\ folder, open these
external VRML files with V-Realm Builder:

base.wrl, convmech.wrl, linkl.wrl, 1link2.wrl, 1ink3.wrl,
link4.wrl, pusher.wrl

With the convmech.wrl world in focus, click the Test Mode button il in the V-
Realm Builder toolbar and view the complete machine in the Main view. Right-click
in this window to configure the navigation. If the colors seem washed out, disable the
headlight.


matlab:mech_conveyor_vr
matlab:mech_conveyor
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Main view Toggle Headlight

BEENE

3 On the left side of your VRML editor window, examine the node tree of
convmech.wrl that refers to the six VRML files representing each component body:

3-17



3 Customizing Visualization and Animation

Virtual world entry
s-% DirectionalLight

-4 DirectionalLight

7@ WorldInfo

=% NavigationInfo

-J=| Background

744 Viewpoint

7-4< Viewpoint

04 LeftTop_View
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The hierarchy of body position and orientation references is flat in this model. Each
body is separately referenced to the top level of the hierarchy, New World.

4 Expand one of the nodes. Each body node has, among others, rotation and translation
fields:
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=% New World

=4 DirectionalLight
=4 DirectionalLight
=@ WorldInfo

=% NavigationInfo
== Background
=-4< Viewpoint

=-4< Viewpoint

=-4¢ LeftTop_View
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SR¥sR Link1 Link1 transform
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@ rotati . .
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[ scaleOrientation
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-[E bboxCenter
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=0 children

The exception is the base. Being grounded and immobile, it has neither a translation
nor a rotation field.

Interfacing the Model and the Virtual World

In mech conveyor vr, open the Body Sensorl block. The block measures the translational
and rotational motion of Link3 in the conveyor:
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1Block Parameters: Body Sensorl x|

—Bodp Senzor

heazures the motion of the Body coordinate system to which the Sensar iz
conhected. Sensor measures any combination of tranzlational pozition, velocity, and
acceleration; and rotational orientation, angular velocity, and angular acceleration.
Choosing the coordinate systerm determines the ases in which the mation
compohents are represented. Output iz a Simulink: zignal. Multiple output signals can
be bundled into one zignal.

—Measurements

With rezpect ta CS: I Absolute [world] LI
¥ Position [xy:z] itz | m ;I
I~ Welocity [x'y'2'] itz | s ;I
[~ Angular velocity [Rx' Ry Rz Lmits: I degds LI
[¥ Rotation matrix [3 = 3]:

[~ Acceleration [="y":2"] riits: I mds"2 j
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The Body Sensorl block has two Simulink output signals.

The other Body Sensor blocks are similar, except for Body Sensor2, which measures only
the translational motion of the pusher. All the Body Sensors measure body motions with
respect to World, the frame in which the conveyor base is at rest. Each motion signal
represents the body's displacement relative to its initial position.

The mech conveyor vr model contains a Simulink 3D Animation subsystem interfacing to
the model's custom VRML files.
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Ground_2

Joint Sensor Torgus

Pasiticn Controller

[Joint Actuator

Simulink 20 Animation

Conveyor with Virtual Reality Scene

Thiz model vizualizes a conveyor in a virtual scene
viewed through Simulink 30 Animation. The
interface between Simiechanics and the virtual
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Conveyor Loader Model with Custom Virtual Reality Animation Interface
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From blocks VR Sink block
1\ AN

Link1\<stian

Link1 translation

Link2.rotstion

Simulink 2D Animation | Link3.

Link4.rotstion,

Link4.

Fushar.

VR Sink

I
RotationMatrix2VR blocks

Custom Virtual Reality Animation Interface Subsystem

1 Trace each body sensor signal. The signals are routed through pairs of Simulink Goto
blocks (in the model) and From blocks (in the custom library).

2 Open the Simulink 3D Animation subsystem, both by double-clicking its icon and by
looking under its mask. The VR Sink block, connected to From blocks transmitting
the body motion signals, and the virtual scene viewer appear. The conveyor loader
virtual scene is similar to that visible in the VRML editor (see “Viewing the Custom
External VRML Files” on page 3-16).
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} convmech -0 x|

File View Viewpoints Navigation Rendering Simulation Recording Help =~
| Default View2 x|/ Examine x| ™ |2 2 d & | W EH || » ®

|Defa|..l View2 . i Pos:[0.55 0.64 1.40] Dir:[-0.08 -0.15 -0.58]

Conveyor Loader Model: Simulink 3D AnimationViewer

From the menu bar of the virtual scene viewer, select Simulation, then Block
Parameters. The VR Sink block dialog opens.

The Source file is convmech.wr1, the master file for this virtual world. The VRML
Tree on the right reproduces the node tree visible in the VRML editor for
convmech.wrl.
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Rotation and
Source file Link1 node translation fields

=) Parameters: VR Sink // _ ol x|
R Sink
Writes Simulink values to virtual world node fields. Fields to be written marked by
checkboes in the tree view, Every marked figld corresponds to an inp rt of the block.,
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Sample time (-1 for inherit): @ > children (MFNode)
= Link2 (Transform)
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(04 | Cancel | Help | Apply |

Conveyor Loader Model: VR Sink Dialog Box

Expand and scroll down the VRML trees. The trees for Link1, Link2, Link3, Link4,
and Pusher list the field inputs for accepting motion signals.

* The Link component bodies require both translational and rotational motions. All
the Links have actively selected check boxes for their rotation and translation
field inputs.

* The Pusher body requires only translational motion. Only the translation field
check box is selected for the Pusher.

Each of the nine Simulink input ports on the VR Sink block is named node. field.
The Base of the conveyor does not move, so its node has no motion input fields.
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5 Ifyou closed the Simulink 3D Animation viewer, you can reopen it from the VR Sink
dialog. Click View in the World properties / Source file area of the dialog.

Close all the dialog boxes by clicking OK, leaving the viewer open.
7  Click the Start button in the model window.
As in the original mech _conveyor example, starting the model opens the Reference

Position slider bar that you can move from side to side. As you do so, watch the
pusher in the viewer move in parallel.
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Reference

[1] Marrin, C., and B. Campbell, Teach Yourself VRML 2 in 21 Days, Indianapolis, Indiana,
Sams, 1997.
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Importing Mechanical Models

Using Simscape Multibody software with computer-aided design (CAD) extends your
mechanical modeling and simulation capabilities, allowing you to create Simscape
Multibody models from CAD assemblies. This chapter covers what you need to get started
with CAD translation. It assumes some familiarity with Simscape Multibody modeling.

“Mechanical Import” on page 4-2

“Generating New Models from Physical Modeling XML’ on page 4-6
“Working with Generated Models” on page 4-11

“Model Update with Physical Modeling XML’ on page 4-20
“Controlling Model Update at the Block Level” on page 4-29
“Troubleshooting Imported and Updated Models” on page 4-40
“Import a CAD Rigid Body” on page 4-44

“Import a Robot Arm Model” on page 4-46

“Import a CAD Stewart Platform Model” on page 4-50
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Mechanical Import

4-2

In this section...

“About Mechanical Import and CAD Translation” on page 4-2
“Requirements for CAD Export and Mechanical Import” on page 4-3

“Essential CAD Translation Steps” on page 4-4

Warning This content is specific to Simscape Multibody First Generation software. First-
generation features are slated to be deprecated and should be avoided.

About Mechanical Import and CAD Translation

Simscape Multibody software features an importer that lets you automatically generate
Simscape Multibody models from an XML file in Physical Modeling format. This externally
defined XML file specifies mechanical information — bodies, degrees of freedom, and
geometry — in a form that the Simscape Multibody importer can use to construct a model
representing that system.

The standard way to obtain such a Physical Modeling XML is to generate it by exporting a
computer-aided aided (CAD) assembly. CAD tools allow you to model mechanical systems
geometrically as collections of parts, or assemblies. You use Simulink and Simscape
Multibody block diagrams to represent control systems composed of mechanical devices
and simulate their dynamics. The block diagram approach does not include full geometric
information, nor do CAD assemblies typically incorporate controllers or allow you to
perform dynamic simulations. With CAD translation, you can combine the power of CAD
and Simscape Multibody software.

The Simscape Multibody Link utility is the necessary intermediary that lets you convert
CAD assemblies into Simscape Multibody models. The intermediate step between CAD
assembly and Simscape Multibody model is exporting an XML file in Physical Modeling
format from the assembly. The export also automatically creates STL files containing body
geometry information that you need for visualizing the bodies in the model.

The Simscape Multibody importer then converts this XML file into a mechanical model,
which references the STL files to visualize the bodies.
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CAD assembly SimMechanics Link & SimMechanics Slmﬂz:é};?mcs
«
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Complete Translation of CAD Assembly Into a Visualizable Model

Requirements for CAD Export and Mechanical Import

The full CAD translation is composed of two distinct steps, with different requirements.

1 The first step is the export of the CAD assembly, which creates the Physical Modeling
XML file and one or more STL file(s).

2 The second step is the import of the Physical Modeling XML file and generation of the
Simscape Multibody model.

CAD Export Software Requirements

To export a CAD assembly into XML, you must first

1 Install your CAD platform or software application.

2  Install the Simscape Multibody Link utility and link it to your CAD platform. The
Simscape Multibody Link utility requires MATLAB only.

Note For CAD export, you do not need Simulink or Simscape Multibody software.

Physical Modeling XML Import Software Requirements

To import a Physical Modeling XML file and generate a model, you must have installed
Simulink and the Simscape and Simscape Multibody products.

Note For XML import, you do not need a CAD platform or the Simscape Multibody Link
utility.
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Essential CAD Translation Steps

Converting a CAD assembly to a Simscape Multibody model requires two major steps,
exporting the CAD assembly into XML, then importing the XML to create a Simscape
Multibody model.

Exporting an Assembly to XML

You export the assembly from the CAD platform into a Physical Modeling XML file that
you can later use with the Simscape Multibody importer. See the Simscape Multibody
Link documentation.

CAD aszembly

Physical Modeling

SimMechanics Link XML file

—
( CAD Platform ]k’” [ T ]

—»| STL file(s)

Exporting a CAD Assembly into a Physical Modeling XML File

4-4

Automatic Export of STL Files Representing CAD Part Geometries

When you export the CAD assembly into Physical Modeling XML, the Simscape Multibody
Link exporter also automatically creates an STL body geometry file for each body
represented as a CAD assembly part. You then need these STL files for Simscape
Multibody visualization, once you create your Simscape Multibody model.

See “Referencing STL Body Geometry Files for Simscape Multibody Model Visualization”
on page 4-5.

Importing the XML and Generating a Model

To complete the CAD translation, you convert the Physical Modeling XML file into a
Simscape Multibody model. See “Generating New Models from Physical Modeling XMIL”
on page 4-6.
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Importing a Physical Modeling XML File into a Model

Referencing STL Body Geometry Files for Simscape Multibody Model
Visualization

Once you have imported the Physical Modeling XML to create a Simscape Multibody
model, you can visualize the bodies in the model. The generated Simscape Multibody
model automatically references the necessary STL body geometry files, one for each body,
to visualize the bodies with their original CAD assembly shapes.
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Generating New Models from Physical Modeling XML
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In this section...

“About Generated Simscape Multibody Models Based on CAD” on page 4-6
“Generating a New Model from a Physical Modeling XML File” on page 4-7

“Controlling New Model Import” on page 4-8

Warning This content is specific to Simscape Multibody First Generation software. First-
generation features are slated to be deprecated and should be avoided.

About Generated Simscape Multibody Models Based on CAD

Note For complete information on exporting Physical Modeling XML, see the Simscape
Multibody Link documentation.

A computer-aided design (CAD) assembly can contain enough part and constraint
information that you can generate a Simscape Multibody model consisting of Body and
Joint blocks representing the assembly. Once you have exported a CAD assembly into a
Physical Modeling XML file, you can generate a Simscape Multibody block diagram model
from this file. A new generated model consists of a single Simscape Multibody machine,
corresponding to an assembly with a single root.

This section shows you how to import the XML file into a Simscape Multibody model
using the command mech_import, which constructs the model.

Requirements for Generating Models by Importing Physical Modeling XML

This section assumes that you have the Simscape Multibody product installed locally or
remotely, and that you have:

* The XML file representing a CAD assembly

* Optionally, STL body geometry files associated with the CAD parts

To generate the Simscape Multibody model, you do not need the CAD platform or

assembly from which the XML file was exported. You also do not need the Simscape
Multibody Link utility.
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Generating a New Model from a Physical Modeling XML File

You generate the CAD-based Simscape Multibody model using the mech_import
command or dialog.

Using the Command Line

To start the model generation from a hypothetical XML file called cad assembly.xml,
enter

mech_import('cad_assembly.xml')

at the command line. A progress bar appears and is updated as the model is imported.

A Simulink model window opens. The model is populated by Bodies and Joints
corresponding to the assembly parts and constraints saved in cad assembly.xml. The
name of the generated model is the name of the original assembly file, regardless of the
name chosen for the XML file.

Using the Import Dialog

You can also select a Physical Modeling XML file and generate a model from it through
the Import Physical Modeling XML dialog. Open it by entering mech_import at the
command line with no arguments. See the mech _import command reference for
complete information about the import dialog. After completing your settings, click OK to
start the import.
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=] Import Physical Modeling XM x|

Import | Advanced Options |

XML file: | [

Import mode

(* Import into new model

" Update existing model

" Add to existing model

" Import into existing mode! (replace model or subsystem contents)

™ Spedfy model to import into {default is model name specified in ¥ML)

Model name: I _I

[~ specify subsystem to import into

Subsystem name: I

Reset to default settings |

‘)’ oK I Cancel | Help | Apply

Controlling New Model Import

You have several options for changing the default import behavior of mech_import and
the Import Physical Modeling XML dialog box. For more information, see “Nondefault
Features in Generated Models” on page 4-14.

Customizing the Generated Model Name

You can specify the name of the generated model in the mech _import command or the
import dialog. The default is to accept the assembly name specified in the XML file.

For example, an XML file called cad assembly.xml could internally specify the
assembly name as CAD Assembly. Generating a model from this XML file leads to a model
name of CAD Assembly. But suppose you want to name it assembly1 instead. Either:

* Enter at the command line
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mech_import('cad assembly.xml', 'ModelToImportInto', 'assemblyl')

This starts the import of cad _assembly.xml and creates a model file called
assemblyl.mdl from it.

* In the dialog's Import tab, select the Specify model to import into check box. In the
Model name field, enter assemblyl and click OK.

Changing the Appearance and Layout of a Generated Model

The Advanced Options dialog tab displays model layout and block appearance controls
in the Layout area. With these, you can make your generated model easier to view and
understand. You can:

* Control how the importer names Joint blocks.

* Control the amount of space the importer creates between blocks.

* Control the direction in which the importer automatically adds blocks to the model.

Layout
¥ Mame joints by joint type

™ Ensure block names do not overlap

Layout direction: IHu:urizontaI vl
You can alternatively use the equivalent options in the mech import function.
Importing into a Subsystem

By default, the importer generates the model starting at the top level of model hierarchy.
It creates subsystems below that level if needed to translate subassemblies.

You can instead import the entire XML file into a subsystem, so that the top level of model
hierarchy is consists of just this subsystem. Subassemblies are then translated into sub-
subsystems below that level. If you import into a subsystem, you must specify names for
both the model and subsystem.

For example, you can import cad _assembly.xml into a subsystem called assembly,
residing in a new model called model assembly. Either

* Enter at the command line
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mech_import('cad assembly.xml',
'ModelToImportInto', 'model assembly',
'SubsystemToImportInto', 'assembly')

This starts the import of cad _assembly.xml into the subsystem.
* In the dialog's Import tab,

* Select the Specify model to import into check box. In the Model name field,
enter model assembly.

* Select the Specify subsystem to import into check box. In the Subsystem name
field, enter assembly and click OK.

Changing the Hierarchy of Moving Joints and Organization of Rigidly Connected
Bodies

The Advanced Options dialog tab displays model simplification controls in the Model
simplification area. With these, you can isolate moving bodies and their DoFs from the
rest of the model. You can:

* Group Bodies rigidly connected by Welds into their own subsystems, each at the
appropriate subsystem level.

* Import non-Weld Joints at the highest level possible, depending on whether you are
importing a model or a subsystem, as well as group rigidly welded Bodies into their
own subsystems. The importer promotes moving Joints in the model hierarchy
regardless of where the corresponding degrees of freedom occur in the original
assembly.

Model simplification

% Mo model simplification

™ Bring imported joints to top level and group welded bodies

" Group welded bodies belonging to same subsystem

You can alternatively use the equivalent options in the mech import function.
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Working with Generated Models

In this section...
“About CAD-Based Models” on page 4-11
“Common Features of CAD-Based Models” on page 4-11

“Nondefault Features in Generated Models” on page 4-14
“Manually Modifying and Extending Generated Models After Import” on page 4-16

Warning This content is specific to Simscape Multibody First Generation software. First-
generation features are slated to be deprecated and should be avoided.

About CAD-Based Models

This section explores the characteristics of a generated CAD-based model, imported with
default or nondefault settings. It also explains when and how to edit your model and
expand it with additional blocks, such as Constraints, Drivers, Actuators, and Sensors.
The section concludes by pointing out major model-generation and simulation errors and
problems that can arise from CAD-based models, and techniques for solving them.

Common Features of CAD-Based Models

Note This section assumes a model generated with default import settings and not yet
edited manually. To see the effects of using nondefault import settings in a newly
generated model, see “Nondefault Features in Generated Models” on page 4-14.

Most of the properties of models that you generate from an XML file are the same as the
default properties of all Simulink models. For information on working with Simulink
models, see the Simulink documentation.

Simscape Multibody models that are successfully generated from CAD-based Physical
Modeling XML have certain common properties that reflect their origin in CAD
assembles:

* Machine Environment, Ground, Body, and Joint blocks only.
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* One Ground block and one connected Machine Environment block for each
Simscape Multibody machine.

* All other automatically generated Simscape Multibody blocks are Bodies and Joints
only, corresponding to the parts, degrees of freedom (DoFs), and constraints of the
Physical Modeling XML file imported.

* The minimum Body coordinate systems and grounded coordinate systems necessary to
connect each Joint to exactly two coordinate systems, one on each side of the Joint.

* Unattached coordinate systems corresponding to reference coordinate systems in the
original assembly and, in general, not associated with constraints.

* Fundamental root, represented by Ground - Root Weld - Root Body. The Root Body
occurs at the top of the main hierarchy. The Root Body has no mass and no inertia, and
does not move.

* Subsystems below the top level encapsulating subassemblies from the original
assembly.

* Subassembly roots, represented by Root Body - Root Weld - Fixed Body. A Root Body
occurs at the top of each subsystem hierarchy if you need such a body to correctly
represent constraints in the original CAD assembly.

* Joints with DoFs containing the correct joint primitives for the translational and
rotational DoFs between any two bodies.

If no appropriate specific Joint exists, the importer inserts a Custom Joint with the
appropriate primitives.
+ Joints without DoFs, represented by Welds.
* Apart from Root Body blocks, each Body block referencing its STL body geometry file.
* Both machine- and model-wide visualization enabled.

This is an example of a model generated from a robot arm assembly.
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Ground Subassembly
Clrobot — ol x]
File Edit View Simulation Format Tools Help
DSHE | fer|cst|[Re|(b s e Q@b hRES \

SimMechanics_RooctGround Weld SimMechanics_RootPart

Ready |

N\ |
Fundamental root

World Coordinate System and the CAD Assembly Origin

A generated model has one Ground. The origin of this Ground is the origin of the World
coordinate system and represents the original CAD assembly origin.

Simscape Multibody Visualization and STL Body Geometry Files

Each body in a generated Simscape Multibody model, apart from the ground and root
bodies, is configured to reproduce the body geometry and color of its original CAD
assembly body. If the needed STL files were created upon export and are referenced by
the generated model, the custom body geometries are visualized. Each Body references
its own STL file.

Caution In order for custom visualization to work, this STL file must be either:

* On your MATLAB path.
* In your MATLAB present working folder.
* Specified with complete path in the Body dialog.

Otherwise, visualization reverts to the default body geometry.
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For More About CAD Assemblies

Fully understanding the structure of a generated model requires understanding the
original system in its CAD representation. Refer to your originating CAD assembly, CAD
platform and associated documentation, and the Simscape Multibody Link documentation.

Nondefault Features in Generated Models

The importer controls allow generation of models with nondefault appearance and
structure. Optional, nondefault coordinate systems can enhance the fidelity and
usefulness of your models.

See “Controlling New Model Import” on page 4-8 and the mech_import function
reference page.

Nondefault Appearance and Layout of Generated Models

The following table summarizes the default and possible nondefault appearance options of
a newly imported model.

Default Appearance and Layout Options Nondefault Appearance and Layout Options

Short Joint block names based on joint type Potentially long Joint block names based on

model hierarchy

Block names that are potentially overlapping Block names that do not overlap

Block diagrams first oriented horizontally from Block diagrams first oriented vertically from top
left to right, then vertically from top to bottom to bottom, then horizontally from left to right

Nondefault Hierarchy and Organization of Generated Models

The following table summarizes the default and nondefault hierarchy and organization
options of a newly imported model.

Aspect of Default Hierarchy & Nondefault Option A Nondefault Option
Hierarchy & Organization B
Organization
Location of At the subsystem level At the highest level of the |Same as default
non-Weld Joints corresponding to the model or subsystem being

subassembly level in the |imported

original CAD assembly
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Aspect of
Hierarchy &
Organization

Default Hierarchy &
Organization

Nondefault Option A

Nondefault Option
B

Grouping of Bodies
rigidly connected by
Welds

Ungrouped and located
individually at the
subsystem level
corresponding to the
subassembly level in the
original CAD assembly

Grouped into their own
subsystem within the
subsystem corresponding
to the subassembly level
in the original CAD
assembly

Same as nondefault
hierarchy A

Coordinate Systems in Generated Models

In addition to the paired coordinate systems automatically generated for Body-Joint
connections, a generated model can contain other coordinate systems:

* Imported versions of reference coordinate systems in the original CAD assembly that
are not, in general, associated with CAD constraints. See “Inserting Reference
Coordinate Systems into Assemblies Before Export” on page 4-40. Upon import,
before manual modifications to the model, these Body coordinate systems are not
connected to other blocks.

* Coordinate systems manually added to the generated model after import. See “Adding
More Coordinate Systems” on page 4-17 .

CAD Assembly

. B1
Translation

@‘ Constraint

P = Part

Generated SimMechanics Model

B =Body J=Joint

M = Paired B-J-B CSs Generated from Constraint

Model After Manual Modification

FF @

—_— — — i
Manual
Editing

# = Reference CS Translated into Unpaired CS

4. = Manually Added Body CS

Coordinate Systems: Automatically Generated, Inserted Before Export, and Manually

Added After Import
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Manually Modifying and Extending Generated Models After
Import

A Simscape Multibody model satisfying full modeling requirements typically contains
other blocks beyond those generated by import. These blocks can include Constraints,
Drivers, Sensors, and Actuators (from the Simscape Multibody block library), as well as
blocks from Simulink, such as Scopes. You manually insert and connect these additional
blocks in your generated model.

Tip When you first generate a model from Physical Modeling XML, you might want to
save this original CAD-based model before you create later versions by eliminating
unnecessary blocks and adding new ones.

Deleting Unnecessary Blocks

The constraint-to-joint mapping creates whatever blocks are needed to correctly isolate
the degrees of freedom (DoFs). In some models, certain generated blocks are not needed
for simulation. You can delete these unnecessary blocks to simplify your model without
affecting its dynamics, as long as you reconnect the remaining blocks properly.

In particular, you can simplify the fundamental root, Ground - Root Weld - Root Body, in
certain cases. (The same holds for subassembly roots. However, the corresponding
subsystem's Root Body takes the place of Ground, and the subsystem's Fixed Body plays
the role of Root Body.)

« Ifthe Root Body is connected to the rest of the block diagram by a single Joint, you
can delete the Root Weld - Root Body blocks and reconnect the Joint directly to
Ground.

+ If the Root Body is connected to the rest of the block diagram by multiple Joints, you
cannot delete the Root Weld - Root Body sequence because a Ground can connect to
only one Joint, and the generated model contains only one Ground. You have two
alternatives in this case:

* Determine where the Root Body coordinate systems (CSs) are. Delete the Root
Weld - Root Body sequence. Then manually add more Grounds at the spatial points
representing each of the deleted Root Body CS origins. Reconnect each Joint to its
corresponding Ground at the correct spatial point.

* Leave the Root Weld - Root Body sequence as it is.



Working with Generated Models

Regrouping, Reducing, and Eliminating Welds

Not all Welds are redundant. Some Welds are needed to connect a Body that otherwise
would be isolated from the rest of the model. Such Welds represent rigid connections
between distinct assembly parts.

» If you want to group Bodies rigidly connected by Welds into their own subsystems, use
the model hierarchy simplification controls in the Advanced Options tab of the
Import Physical Modeling XML dialog box or mech import function.

* Ifyou want to reduce or eliminate such Welds, return to your original assembly and
reexport it with rigid subassemblies. See the Simscape Multibody Link documentation.

Adding More Coordinate Systems

In addition to the automatically generated pairs of coordinate systems that connect Joints
representing CAD constraints, you can also add your own coordinate systems to Bodies,
after import. If you want to add Constraint, Driver, Actuator, or Sensor blocks to a
generated model, and connect these blocks to one or more of the Bodies, you need extra
Body coordinate systems as connection points.

These sections describe how to add Body coordinate systems to a Body:

* “Modeling Grounds and Bodies”
* “Working with Body Coordinate Systems”

Reference Coordinate Systems in the Original Assembly

You can also insert reference coordinate systems, in general not associated with
constraints, in the original assembly before export. You might find positioning and
orienting such coordinate systems easier in the CAD environment. Translation preserves
these coordinate systems, which appear in the generated model in addition to the
coordinate systems pairs connecting Joints and Bodies.

For more information, see “Inserting Reference Coordinate Systems into Assemblies
Before Export” on page 4-40.

Constraining and Driving Degrees of Freedom

Constraints reduce the number of independent degrees of freedom in a mechanical
system by preventing certain movements. Drivers affect DoFs, not by eliminating them
completely, but by forcing their motions to follow an external time-dependent signal. A
constrained or driven DoF is not free to respond to forces and torques independently.
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These sections discuss how to add constraints and drivers to your model:

* “Constraining and Driving Degrees of Freedom”
* “Actuating a Driver”

Note You insert these constraints into the Simscape Multibody model as blocks. They act
in addition to the part constraints in the original CAD assembly.

Actuating Bodies and Joints with Motions and Forces

You can actuate bodies and joints in your Simscape Multibody models with external forces
and motions and set up internal forces between bodies. You can also vary the mass or
inertia (or both) of a body in time. Consult these sections for more details:

* “Actuating a Body”

* “Varying a Body's Mass and Inertia Tensor”

* “Actuating a Joint”

* “Adding Internal Forces”

Setting the Model's Initial Conditions

When you import a CAD assembly into the Simscape Multibody environment, the XML file
determines the initial geometric configuration of the model's bodies. By default, the initial
velocities of the bodies are zero, and the model is in home configuration.

If you want to change the initial positions and/or velocities of the bodies in your model to
be different from the CAD-determined configuration, you need to add initial condition
actuators, as discussed in “Specifying Initial Positions and Velocities”.

Sensing Forces and Motions

To detect the motions of bodies and joints and measure the forces acting on or through
them, you can add sensors to your model. See “Sensing Motions and Forces”.

Satisfying Simscape Multibody Model Validity Requirements

You can find the general instructions for building valid Simscape Multibody models in
these sections:
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» “Representing Machines with Models”
* “Validating Mechanical Models”

Changing Custom Body Visualization Geometries and Colors

When it generates the Body blocks in a model (except for Root Bodies), the Simscape
Multibody importer automatically customizes the body geometries for visualization by
referencing the STL files associated with the CAD assembly export. It also automatically
customizes the body colors to match the original CAD part colors, which are captured by

the exported XML file.

You can manually reset the custom visualization on one or more of these Bodies, changing
body shape, color, or both. See the Body block reference page and “About Custom
Simscape Multibody Visualization” on page 3-2.
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In this section...

“About Model Update and Mechanical Import” on page 4-20
“Updating a Machine in a Generated Model with Revisions” on page 4-23
“Adding a New Machine to a Generated Model” on page 4-25

“Replacing Generated Model or Subsystem Contents with a New Machine” on page 4-
26

Warning This content is specific to Simscape Multibody First Generation software. First-
generation features are slated to be deprecated and should be avoided.

About Model Update and Mechanical Import

Note For the steps to generate a model by importing, see “Generating New Models from
Physical Modeling XML’ on page 4-6.

For complete information on exporting Physical Modeling XML, see the Simscape
Multibody Link documentation.

The mech _import command and import dialog let you update models previously
generated from Physical Modeling XML. After revising the model's originating CAD
assembly, you export a new XML file representing the changed system. You can import
this new XML file to generate a new Simscape Multibody model, although you would have
to repeat on the new model whatever manual, post-translation work you did on the old
model.
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Export > Physical Modeling Import > SimMechanics

CAD assembly

XML file model
I
C“’ﬁﬁifj;j;“:‘ | ———P| STL file(s)
i_R_EBVg:d_ CID—‘lﬂort New Physical Modeling| IMPort | New SimMechanics
| assembly | ] XML file | model

> New STL
file(s)

Translating a Revised CAD Assembly by Generating a New Simscape Multibody
Model

But you can also update-import: import the new XML file to update the existing model.
Update-importing allows you to retain whatever manual, post-translation work you did on
the old model. You also keep any unchanged CAD-related features of the model.

Export Physical Modeling | {mport SimMechanics
CAD assembly > XML file > model

CAD assembly | |

revisions | P STL file(s) |
|

,___L__, Update- |———_‘____|

| Revised CAD | Export > New Physical Modeling| Import Updated |

| assembly | XML file [ SimMechanics model |

» New STL
file(s)

Translating a Revised CAD Assembly by Updating an Existing Generated
Simscape Multibody Model
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Updating by Subsystem, Machine, and Model

Update-import encompasses three distinct ways of revising a generated model with
revised assembly information. It revises by blocks within a machine, an entire machine,
an entire subsystem, or the entire model.

» Updating an existing machine in the model, which might include adding new blocks to
the machine

* Adding a new machine to the model

* Replacing model or subsystem contents with entirely new contents

Note Update-import respects the model-machine-subsystem hierarchy of an existing
model. If you want to change this existing model hierarchy, you must manually edit the
generated model or generate a new model from your CAD assembly or XML file.

Requirements for Updating a Previously Generated Model by Importing Physical
Modeling XML

This section assumes that you have the Simscape Multibody product installed locally or
remotely, and that you have:

* The XML file representing a revised CAD assembly

* The generated Simscape Multibody model you want to update

* Optionally, the STL body geometry files associated with the CAD assembly

To update-import the model, you do not need the CAD platform or assembly from which
the XML file was exported. You also do not need the Simscape Multibody Link utility.

Inheritance Relationships Between Assemblies and Models

See “Controlling Model Update at the Block Level” on page 4-29 for a complete
explanation of the inherited structure and identity shared by assemblies and models
based on them.

Controlling the Automatic Backup of Updated Models

Updating an existing generated model erases previous model information. But, by default,
the importer saves a copy of the previous version of the model through automatic backup.
You can control this automatic backup through the options in the mech import command
or the import dialog. You can choose any one of these possibilities
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* Back up your previous model version in the same folder as the new version. This is the
default.

» Back up your previous model version in a different folder, which you specify.
* Do not back up your previous model version at all.

You can set these options through the Backup mode pull-down menu in the Backup area
of the Advanced Options tab of the import dialog.

Backup

Backup mode: ICreate backup in same directory LI

Backup model location: I I

Revisions to STL Body Geometry Files

Any revisions to an existing CAD assembly are reflected in the new set of exported STL
files that replace the old set of STL files from the earlier version of that assembly. Each
updated Body block continues to reference its corresponding STL file.

Updating a Machine in a Generated Model with Revisions

Revising a Simscape Multibody model previously generated from a CAD assembly means
that the importer translates changes to assembly part and constraint properties into
changes in Body and Joint properties. Depending on the nature of the assembly changes,
new blocks and connections can be added as well, and individual blocks can be replaced.
Property changes include changes to body mass properties and to body and grounded
coordinate system (CS) properties. Revising changes or extends only a single machine in
the model with revisions.

You start such an update-import with either

* The mech import command; see the command reference page.

* The import dialog. On the Import tab, under Import mode, select Update existing
model. After configuring and applying the settings, click OK.

Using the two fields at the bottom of this tab, you can enter a nondefault model name,
and possibly a subsystem name, into which to import the revisions. The default is for
the importer to take the model and subsystem names from the XML file. In either case,
the specified model, and possibly subsystem, must exist for the update-import to
succeed.
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=] Import Physical Modeling XM x|

Import | Advanced Options |

XML file: | [

Import mode

¢ Import into new model

(* Update existing model

" Add to existing model

" Import into existing mode! (replace model or subsystem contents)

™ Spedfy model to import into {default is model name specified in ¥ML)

Model name: I _I

™ Specify subsystem containing blocks to update

Subsystem name: I
(Subsystem containing blocks to update must exist)

Reset to default settings |

‘)’ oK I Cancel | Help | Apply |

Controlling the Appearance and Hierarchy of an Updated Machine

An update-import can change the appearance of a generated machine. In both the

mech _import command and on the Advanced Options tab of the import dialog, you can
control how these changes occur. These controls are similar to the controls available for
importing a new model. See “Controlling New Model Import” on page 4-8.

* In the Layout area, you can require that the importer label new Joint blocks with short
names based on the Joint type.
* Inthe Update area, you can require the importer to:

* Find the best spatial arrangement of the blocks.

* Import new Joint blocks at the highest level, depending on whether you are
importing into a model or a subsystem, and regardless of where the corresponding

degrees of freedom occur in the original assembly.
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Layout
¥ Mame joints by joint type
I™ | Ensure block names do not overlap

Layout direction: IHc.rizc.ntaI vl

Update

[~ Arrange all imported blocks

¥ Respectindividual block update settings

[T Add new joints at top level

Controlling How Update-Import Changes Individual Blocks

In the Update area, you can use Respect individual block update settings to control
on a block-by-block basis how the importer changes blocks and their connections with
updates. Proper control of individual block updating requires understanding how a
generated model “remembers” its originating assembly. See “Controlling Model Update at
the Block Level” on page 4-29.

Adding a New Machine to a Generated Model

Adding a new machine to a Simscape Multibody model previously generated from a CAD
assembly means that the importer translates a completely new assembly into additional
Bodies, Joints, and subsystems. Such changes do not include updating existing machines
in the model.

You start such an update-import with either:

* The mech_import command; see the command reference page.

* The import dialog. On the Import tab, under Import mode, select Add to existing
model. After configuring and applying the settings, click OK.

Using the two fields at the bottom of this tab, you can enter a nondefault model name,
and possibly a subsystem name, into which to import the revisions. The default is for
the importer to take the model and subsystem names from the XML file. In either case,
the specified model, and possibly subsystem, must exist for the update-import to
succeed.

If you are adding a new subsystem, select the Create new subsystem if it does not
exist check box.
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=] Import Physical Modeling X|

Import | Advanced Options |

XML file: | [

Import mode

¢ Import into new model

" Update existing model

{+ Add to existing model

" Import into existing mode! (replace model or subsystem contents)

™ Spedfy model to import into {default is model name specified in ¥ML)

Model name: I _I

™ specify subsystem to import into

Subsystem name: I

[~ Create new subsystem if it does not exist

Reset to default settings |
.‘) Ck I Cancel | Help | Apply |

Controlling the Appearance and Hierarchy of an Updated Model with an Added
Machine

An update-import with an additional machine changes the appearance and hierarchy of a
model. In both the mech_import command and the Layout and Model Simplification
areas of the Advanced Options tab of the import dialog, you can control how these
additions occur, in the same way as if you were generating a new model. See “Controlling

New Model Import” on page 4-8.

Replacing Generated Model or Subsystem Contents with a
New Machine

Replacing model and subsystem contents in a Simscape Multibody model previously
generated from a CAD assembly means that the importer either:

* Completely erases the contents of the model at the top level and replaces these
contents with an entirely new machine.
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* Completely erases the contents of a subsystem and replaces these contents with an
entirely new subsystem.

Warning Update-importing by replacement deletes the previous contents of the model or
subsystem. If you need to retrieve the old contents, use the model's backup copy. See
“Controlling the Automatic Backup of Updated Models” on page 4-22.

You start such an update-import with either:

* The mech_import command; see the command reference page.

* The import dialog. On the Import tab, under Import mode, select Import into
existing model (replace model or subsystem contents). After configuring and
applying the settings, click OK.

Using the two fields at the bottom of this tab, you can enter a nondefault model name,
and possibly a subsystem name, into which to import the revisions. The default is for
the importer to take the model and subsystem names from the XML file. In either case,
the specified model, and possibly subsystem, must exist for the update-import to
succeed.
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=] Import Physical Modeling XM

Import | Advanced Options |

XML file: |

Import mode

¢ Import into new model
" Update existing model

" Add to existing model

* Importinto existing model (replace model or subsyste@

™ Spedfy model to import into {default is model name specified in ¥ML)

Model name: I

|

[~ Specify subsystem to import into

Subsystem name: I

(Subsystem to import into must exist)

Reset to default settings |

[ o |

Cancel | Help

J

| Apply

Controlling the Appearance and Hierarchy of an Updated Model or Subsystem

with Replaced Contents

An update-import with completely replaced contents changes the appearance and
hierarchy of a generated model or subsystem. In both the mech _import command and
the Layout and Model Simplification areas of the Advanced Options tab of the import
dialog, you can control how these additions occur, in the same way as if you were
generating a new model. See “Controlling New Model Import” on page 4-8.
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Controlling Model Update at the Block Level

In this section...

“Associativity and Updating” on page 4-29
“Working with Associativity in Common Updating Situations” on page 4-31

“Controlling How Update-Import Changes Individual Blocks and Connections” on page 4-
33

“Associativity in an Updating Sequence Example” on page 4-36

Warning This content is specific to Simscape Multibody First Generation software. First-
generation features are slated to be deprecated and should be avoided.

Associativity and Updating

To update an existing generated Simscape Multibody model with changes to its original
external definition (a CAD assembly, for example), the intermediate XML multibody
description file and the model itself must retain information about the identities of at least
some of its components. This section explains this “identity memory” or associativity.

What Is Associativity?

Associativity is a key concept for understanding the relationship between CAD assemblies
and Simscape Multibody models based on them, and the export and updating process that
defines Simscape Multibody models from CAD assemblies.

Associativity Between CAD Assemblies and Simscape Multibody Models

Associativity is a persistent (session-independent) parallel relationship among certain
components of a CAD assembly, XML multibody description files exported from it, and
Simscape Multibody models generated from the XML files.

This relationship preserves the identities and parallelisms of certain CAD components and
the corresponding imported components of the Simscape Multibody model. The Simscape
Multibody Link exporter defines these unique identities from the CAD assembly
components and embeds them in the exported XML multibody description file. Simscape
Multibody models generated from the XML file in turn retain these identities.
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You actualize associativity when you generate a Simscape Multibody model from a CAD
assembly. Associativity is a mapping between parts, constraints, and subassemblies in a
CAD assembly and the corresponding Body and Joint blocks, coordinate systems, and
subsystems in the Simscape Multibody model generated from that CAD assembly. It
uniquely captures the identities of these CAD components, their corresponding blocks,
and their topology (how they are connected to one another).

Associativity is not completely symmetric between the CAD and Simscape Multibody
worlds, because the translation process moves in one direction only, from CAD assembly
to generated Simscape Multibody model.

When and Why You Need Associativity

Associativity is required for updating a generated Simscape Multibody model when its
originating CAD assembly has been changed.

How Associativity Is Implemented

When you use the Simscape Multibody Link exporter to create an XML multibody
description file from a CAD assembly, these components receive unique XML identifiers.
When you use the Simscape Multibody importer to generate a Simscape Multibody model
from the XML file, the identifiers are preserved in the corresponding Simscape Multibody
model features.

Parallel Identities Between CAD Assembly and Simscape Multibody Model Components
Captured by Associativity

CAD Assembly Components Corresponding Imported Simscape Multibody
Model Components

Parts and grounds Body and Ground blocks

Constraints between parts Joint blocks

(allowed motions)

Constraints between parts Paired coordinate systems attached to Joints

(positions and orientations)

Reference coordinate systems Body coordinate systems unattached after import

Subassembly hierarchy Subsystem hierarchy

Changing Assemblies, Generated Models, and Their Associativity

The associativity of CAD assembly and generated Simscape Multibody model is open,
modifiable, and extensible. As long as a generated Simscape Multibody model retains at
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least one associated imported component, this model retains some associativity with its
originating CAD assembly.

Preserving associativity

You preserve the original associativity if you do not remove or reconnect associated
components in either the CAD assembly or the Simscape Multibody model.

Changing the properties of an associated component, without removing or reconnecting
it, both uses and preserves associativity.

Extending associativity

You extend the original associativity if you add new, associable components to the CAD
assembly, export the assembly, and update-import the generated Simscape Multibody
model. The new components generated in the updated Simscape Multibody model are
associated with the new components of the CAD assembly.

Modifying associativity
You modify the original associativity if you remove or reconnect one or more associated
components in the Simscape Multibody model.

* The associativity of the removed or reconnected associated components is destroyed.

* The associativity of the other associated components, and of the Simscape Multibody
model as a whole, remains intact.

* You recreate the original associativity of the removed or reconnected components in
the Simscape Multibody model if you reimport the unchanged components from the
CAD assembly.

Replacing associativity

You replace the original associativity if you remove or reconnect one or more associated
components in the CAD assembly.

Once you export the CAD assembly and update-import the Simscape Multibody model, the
associativity of the removed or reconnected components is destroyed. In this case, the
component is either connected in a new way, with a new associativity, or it is removed
altogether.

Working with Associativity in Common Updating Situations

The unique parallel identities created by associativity allow you to revise and expand CAD
assemblies, then export the changed CAD assemblies and update existing Simscape
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Multibody models based on them. While you can also create entirely new Simscape
Multibody models from the updated XML, associativity saves the effort invested in editing
and testing by reusing existing Simscape Multibody models.

The following translation cases cover the basic possibilities. You can combine some of
them into more complex, compound cases. For example, you can change a CAD assembly
by both revising existing component properties and adding new components.

Exporting a CAD Assembly and Generating a Simscape Multibody Model for the
First Time

During CAD export, Simscape Multibody Link assigns a unique XML identifier to each
CAD component. When you import the XML file and generate a Simscape Multibody
model from it, the corresponding model components listed in the table's second column
receive these parallel identities.

Updating a Generated Simscape Multibody Model by Modifying CAD Assembly
Properties

If you modify a CAD assembly and export a new XML multibody description file from it,
updating the model with the modifications allows you to reuse an existing Simscape
Multibody model that was previously translated from the same assembly.

You update a generated Simscape Multibody model when you import the XML multibody
description file for the modified CAD assembly. The updated model reflects the new
component properties in the modified assembly.

Associativity identifies the components in the existing generated Simscape Multibody
model so that the importer can update their properties.

Updating a Generated Simscape Multibody Model by Extending the CAD
Assembly

If you add more components to a CAD assembly and export a new XML multibody
description file from it, updating the model with the extensions allows you to reuse an
existing Simscape Multibody model previously translated from the same CAD assembly.

You extend a CAD assembly when you add one or more components to it. You update a
generated Simscape Multibody model when you import the XML multibody description
file for the extended CAD assembly. The updated model contains new blocks representing
the new components in the extended assembly. Blocks representing original CAD
components remain unchanged.
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Associativity identifies the original components in the existing generated Simscape
Multibody model so that the importer does not change them while adding the new
associated components.

Modifying a Generated Simscape Multibody Model Associated with a CAD
Assembly, Then Updating Its Associated Components

You can also manually add nonassociated components to an existing Simscape Multibody
model previously generated from a CAD assembly, separately revise the assembly, then
retranslate the assembly by update-importing the Simscape Multibody model with the
revisions.

* The associated Simscape Multibody model components are updated with the CAD
assembly revisions.
* The nonassociated Simscape Multibody model components are not unchanged.

» If the nonassociated Simscape Multibody model components are connected in the
original model to associated blocks, they might become disconnected after update-
import.

* Nonassociated model components can include Constraints, Drivers, Actuators, and
Sensors that you manually added and connected to associated, imported Bodies
and Joints.

* Nonassociated model components can also include Bodies and Joints added
manually after you generated the original Simscape Multibody model. These Bodies
and Joints were not import-generated and therefore cannot be associated.

Controlling How Update-Import Changes Individual Blocks and
Connections

You can modify how the update-import process changes the updated model.

Enabling and Disabling Automatic Update of Individual Associated Blocks

If you want to prevent the update-import process from updating or removing particular
blocks in a generated model, you can disable the updating or removal for individual
blocks. Doing this does not erase any associativity information from these blocks, and you
can reenable automatic updating as long as the block exists in the model.

To enable automatic updating for an individual associated block:
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1 Right-click the block and select the Simscape Multibody menu item.
2 Clear Retain without updating properties. This is the default.

B | —

EHHA 7 ==
updating properties

I

Retain without
e ————

To disable automatic updating for an individual associated block:

1 Right-click the block and select the Simscape Multibody menu item.
2 Select Retain without updating properties.

cs :C’»W——Q’H cefly

v Retain without updating properties
e —— ______.--"""

Note The right-click submenu item is available only on associated blocks. The default for
Retain without updating properties is cleared. That is, the default is that automatic
block updating is enabled.

Respecting and Overriding Associated Block Update Settings During Model
Update-Import

You can override individual associated block update settings for the model update as a
whole.

In the import dialog, you can specify whether the update-import respects or overrides
these individual block settings on the Advanced Options tab. (The mech import
command allows you to set an equivalent option as a command input.)

» To require that the update-import respect the individual associated block update
settings, select the Respect individual block update settings check box. This is the
default.
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Import  Advanced Options |
Update

[ Arrange all updated blocks

ﬂespect individual block update sethzg__s::b

» To override the individual associated block update settings, clear the Respect
individual block update settings check box.

Import  Advanced Options |
Update

[~ Arrange all updated blocks

ﬂspect individual block update setﬁnD

Preserving and Breaking Connectivity of Nonassociated Blocks to Updated
Associated Blocks

If you want the update-import to preserve the connections of individual nonassociated
blocks to associated blocks, you can enable connection preservation for individual blocks.
You can also allow the update-import to break such connections. Allowing connection
breaking does not remove the nonassociated block. You can reconnect it manually and
reenable connection preservation again as long as the block exists in the model.

To always preserve the connection of an individual nonassociated block from an updated
associated block:

1 Right-click the nonassociated block and select the Simscape Multibody menu item.
2 Select Retain connectivity to imported blocks. This is the default.
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%/‘ - - i e
Joint 54 v Retain connectivity to imported blocks
e
Explore

To allow automatic disconnection of an individual nonassociated block from an updated
associated block:

1 Right-click the nonassociated block and select the Simscape Multibody menu item.
2  Clear Retain connectivity to imported blocks.

EIae

%/‘ icnoud
EMW to mported locks_

_—--#--
Explore |\

Note The right-click submenu item is available only on nonassociated blocks connected
to associated imported blocks. The default for Retain connectivity to imported blocks
is selected. That is, the default is that automatic updating preserves the nonassociated
block's connection to associated blocks.

Associativity in an Updating Sequence Example

This example shows how associativity works and how you can use it in a simple three-
body mechanical system translated from a CAD assembly to a Simscape Multibody model.
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The machine consists of three bodies connected in a chain. The first and second bodies
are constrained with one type of allowed motion. The second and third bodies are
constrained with another type of allowed motion.

Translating the Assembly and Generating the Model for the First Time

The initial translation from the CAD assembly results in a Simscape Multibody model with
three bodies (B1, B2, B3) connected in a chain by two joints (J1, J2). These associated
model components are the Body and Joint blocks and the Body Coordinate Systems (CSs)
that connect the Bodies through the Joints.

CAD Assembly SimMechanics Model
T
Constraint Associated Model Components:
—_ - E ¢ Bodies
Initial Model + Joints
Generation ¢ Coordinate Systems (CSs)
Constraint
o
P = Part BE=Body J=Joint m=CS5

Revising an Assembly Body, Manually Adding Nonassociated Sensors in the
Model, and Updating the Model from the Assembly

The next step is to revise the assembly by changing some properties of one of the
assembly parts (P2). At the same time, you add two new, nonassociated components to the
generated model: a Joint Sensor (JS) and a Body Sensor (BS).

You then update-import the model from the revised assembly. The body properties of B2
are updated. Assuming you keep the default settings, the connections of the
nonassociated Joint and Body Sensors to J1 and B3, respectively, are retained.
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Revised Assembly: SimMechanics Model: Nonassociated Sensors Manually Added,
Change to P2 Then Associated Body B2 Automatically Updated

=@ A

E Nonassociated Model Components:

. # Joint Sensors
Automatic Update-Import e Body Sensors

Not Changed by Update-Import

B3

P =Part B=Body J=.Joint m=CS5
J8 = Joint Sensor BS = Body Sensor

Manually Replacing an Associated Model Joint and Updating the Model from the
Assembly: Update Options

The last step in the example is to manually replace one of the model joints (J2) with a new,
nonassociated Joint block (J3). If you update-import the model from the assembly now, you
must choose how to update the replaced joint ]3:

* You can override the manual joint replacement.

The old joint J2 is reimported and re-replaces the manually inserted joint J3. This is
default setting on Simscape Multibody blocks.

* You can require that the manual changes be retained.

The newly added joint J3 is retained. This choice requires you to change the default
setting on the relevant Simscape Multibody blocks.

The import default is to respect the individual block settings in any case, although you
can change that as well.
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No Change SimMechanics Model: Associated Joint Manually Replaced:
to Assembly J2 — J3. Then Choose How to Automatically Update.

Choose How Joint J3 Is Updated:

—_— - E + Retain Manually Added Joint J3
Automatic + Override Manual Addition and
Update-Import Reimport Original J2.
B3 I
P = Part E =Body J=Joint m=CS

J5 = Joint Sensor BS = Body Sensor
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Troubleshooting Imported and Updated Models

In this section...

“Best Practices for Creating and Exporting Assemblies” on page 4-40

“Inserting Reference Coordinate Systems into Assemblies Before Export” on page 4-40
“Controlling Mechanical Import to Assist Troubleshooting” on page 4-41
“Troubleshooting Errors During Model Generation” on page 4-41

“Troubleshooting Errors During Model Update” on page 4-42

“Troubleshooting Model Simulation Errors” on page 4-42

“Troubleshooting Simscape Multibody and Simulink Problems” on page 4-43

Warning This content is specific to Simscape Multibody First Generation software. First-
generation features are slated to be deprecated and should be avoided.

If your CAD assembly was not constructed or exported properly, you might encounter
problems in your generated Simscape Multibody model.

Best Practices for Creating and Exporting Assemblies

The Simscape Multibody Link documentation presents instructions and tips on these
topics:

* Constructing a CAD assembly specifically for Simscape Multibody

+ “Fixing” subassembly parts and subassembly roots

* Exporting a CAD assembly

* Identifying and fixing export errors

Inserting Reference Coordinate Systems into Assemblies
Before Export

Translation might not place Body coordinate systems where you need them in the

imported model, to attach Joint, Constraint, Driver, Actuator, or Sensor blocks. If so,
insert reference coordinate systems into the CAD assembly at the appropriate positions
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and orientations and re-export the assembly into an XML file for import. These pre-export
reference coordinate systems appear on the corresponding Body blocks after import.

For more information, see:

* “Coordinate Systems in Generated Models” on page 4-15.
* “Adding More Coordinate Systems” on page 4-17.

Note Inserting and optionally exporting reference coordinate systems is not supported
for all CAD platforms supported by Simscape Multibody Link software.

Controlling Mechanical Import to Assist Troubleshooting

Both the Import Physical Modeling XML dialog box and the mech_import function have
model generation controls that can assist you in isolating errors in a newly imported
model. You can:

* Make the Joint blocks, the Body blocks rigidly connected by Welds, or both, in your
model easier to locate by using the model hierarchy simplification options.

* Make the Joint and other blocks easier to locate and identify by changing the model
layout options.

Troubleshooting Errors During Model Generation

Errors in the Physical Modeling XML file appear as warnings at the MATLAB command
line during model generation.

Identifying and Fixing Joint Translation Errors

Warnings arise from CAD constraint translation errors encountered when the XML file
was originally exported. Such errors occur when the translator fails to map one or more
CAD constraints, which restrict the degrees of freedom between parts, into their
corresponding Simscape Multibody joints. The exporter warns you at the export step if
such errors occur.

The failed Joint appears in your generated model as a Weld. You can fix such an error in
two ways:
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* Return to the original CAD assembly, reconfigure the constraint, and export it again.
* In the generated model, manually replace this Weld with a proper moving Joint.

Tip If you need reference coordinate systems on Bodies to facilitate repairing
mistranslated Joints after import, see “Inserting Reference Coordinate Systems into
Assemblies Before Export” on page 4-40.

Troubleshooting Errors During Model Update

Update-importing an existing generated model can produce the same types of errors as
importing a new model. The preceding discussion in this section explains these potential
errors and how to identify and fix them.

In addition, you might update-import an existing generated model in a way that is
technically correct, but not what you intended. To prevent such inadvertent errors,
review:

* “Model Update with Physical Modeling XML’ on page 4-20

* “Controlling Model Update at the Block Level” on page 4-29

Troubleshooting Model Simulation Errors

Certain problems with CAD-based models appear only when you run the model.

* You must “fix” at least one part in every CAD subassembly by mating it to the
subassembly root. Otherwise, the massless root body is dynamically active and
experiences infinite acceleration when forces or torques are applied to it.

* Ifyou find constraints are violated while your model is running, try the following:

* Examine your original CAD assembly for redundant constraints.

* Check and possibly increase the assembly tolerances at the original CAD export
step.

* Check and possibly increase the translated model's assembly tolerances in the
machine's Machine Environment block, in the Parameters tab.

* On the Constraints tab in the Machine Environment dialog, select the Use robust
singularity handling check box.
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* Decrease the assembly tolerances at the original CAD export step.

Caution Never decrease assembly tolerances in a CAD-based Simscape Multibody model.
Instead, decrease them in the original assembly, then reexport.

Troubleshooting Simscape Multibody and Simulink Problems

You might also encounter general Simulink or Simscape Multibody problems while
running your model.

» For Simscape Multibody problems, see “Troubleshooting Simulation Errors”.
* For general Simulink problems, consult the Simulink documentation.
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Import a CAD Rigid Body

Warning This content is specific to Simscape Multibody First Generation software. First-
generation features are slated to be deprecated and should be avoided.

This example shows you how to import a simple CAD assembly into Simscape Multibody
software. The assembly is a simple cup with zero mechanical degrees of freedom. The
example requires export of the cup assembly from a supported CAD platform using
Simscape Multibody Link.

To generate a model from a CAD assembly, you import the Physical Modeling XML file
that Simscape Multibody Link generates during CAD Export.

1 Move or copy the exported XML file into a MATLAB working folder to generate a
Simscape Multibody model from the file.

2 Generate the model from cup_assembly.xml with the mech _import command.

] cup_assembly * _ - ol x|

File Edit View Simulation Format Tools Help
NEFES| BB (E= 422 » mfioo | [Noma | o @ |

[: 3 B F m cofgrss g B F o cs o

RootPart

Ready [100% | [ |odeds .

Once you generate the Simscape Multibody model, it has six blocks, a combination
representing the entire assembly:

Machine Environment - Root Ground - Weld - Root Part - Weld - Cup

* The Ground origin is coincident with the World origin and maps the CAD assembly
origin.

» The Root Part is a nondynamical zero-mass/zero-inertia body inserted between ground
and the cup.
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» The second joint is a Weld because the original CAD assembly has no degrees of
freedom.

Deleting the Root Part and one of the Welds does not physically change the model, as long
as you reconnect the remaining blocks.
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Import a Robot Arm Model
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Warning This content is specific to Simscape Multibody First Generation software. First-
generation features are slated to be deprecated and should be avoided.

This example shows you how to import the model of a robot arm CAD assembly. The
import procedure makes use of the mech_import command. You use the command to
specify the Physical Modeling XML file that Simscape Multibody Link generated during
CAD Export.

Generate a Simscape Multibody model for the robot arm based on the file robot.xml.
You can use this preconfigured example file or export your own version of the XML file
from the robot arm CAD assembly. In either case, copy or move the XML file to your
MATLAB working folder.

Import Simscape Multibody XML File

The preconfigured robot.xml file is in the Simscape Multibody demos folder.

1 Generate the model by entering mech import('robot') at the command line.

The status bar opens and indicates the progress of model generation. A model
window, named robet, opens and is populated with blocks.

2 Save this initial body-joint model as robot, and note these properties:

* The top level of the model has 13 blocks and the grip-1 subsystem.
* The grip-1 subsystem has 18 blocks.

The original robot arm assembly has eight DoFs, with two in the grip subassembly
and six at the top level. These translate into eight DoFs in the Simscape Multibody
model, where:

* Six DoFs occur at the top level. These include the upper arm relative to the
base, the forearm relative to the upper arm, the wrist relative to the forearm,
and the grip relative to the wrist.

* Two DoFs occur in the grip-1 subsystem. These are the rotational DoFs of the
two grip fingers.



Import a Robot Arm Model

There are eight revolute primitives in the subsystem. They occur in two closed
loops as two independent four-bar mechanisms. Each four-bar mechanism
actually has only one independent DoF because each four-bar loop closes on
itself.

Note

Modify Imported Model

To modify and extend the robot arm model, you need blocks from the Simscape Multibody
and Simulink block libraries. Open these libraries by entering mechlib and simulink,
respectively, at the command line.

Remove Redundant Rigid Bodies

Some of the bodies in the generated robot arm model are redundant. You can remove
them without affecting the model's dynamics, as long as you properly reconnect the
remaining blocks.

* At the top level, the RootPart block is a zero-mass, zero-inertia Root Body. You can
delete it, along with the connected Weld1 block, then reconnect the Root Ground to
the base-1 block through the Weld block.

* In the grip-1 subsystem, you can delete the grip-1 (Root Body) block and the
connected Weld block because they are unnecessary. You can also delete the
associated Body coordinate system on the metacarpal-1 Body block.

See the reference page for more details about the Body block.

Add Actuator and Sensor Blocks

You can motion-actuate the wrist relative to the forearm.

1  Double-click the Revolute that connects the forearm-1 and wrist-1 Body blocks.
Change the Number of sensor/actuator ports to 2.
2 Click OK. Two new ports appear on the Joint.

3 Add the following blocks to the model and connect them to the two new ports.
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Block Library Quantity
Joint Actuator Sensors and Actuators 1
Joint Sensor Sensors and Actuators 1

4 Configure the Joint Actuator to accept motion signals. Be sure the angular units are
deg (degrees).

5 From the Simulink library, insert a Sine Wave, a Mux, two Integrator blocks, and one
Scope block. Connect them to the previous blocks as shown in the following figure.
Rename the Scope block to Pitch Angle.

—m|csilpess m| coiprss m—

forearm-1 wrist-1

Joint Actuator

:I Fitch Angle
Integratard
Int: 1 1—
ntegrator = ‘
\ Lower
Integrator
Sine Mfawe % Blﬂl:k

6 In the Sine Wave block, set the Amplitude to 60*pi*pi and the Frequency to 60.
Leave all other defaults.

7 In the lower Integrator block, set Initial condition to -60*pi. Leave all other
defaults.
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Configure Tolerances

The original robot arm CAD assembly requires looser tolerances than the Simscape
Multibody defaults, and its motion can lead to singularities. To avoid simulation errors or
slowdown, you need to reconfigure the assembly tolerances and constraint solver:

1 Open the Machine Environment block.

2  On the Parameters tab, reset the Linear assembly tolerance to 1e-2 m (meters)
and the Angular assembly tolerance to le-1 rad (radians).

3  On the Constraints tab, select the Use robust singularity handling check box.
Leave all other defaults. Click OK.

4 Resave your finished model as robot3.

Simulate and Visualize Robot Arm Motion
Run robot3 and examine its motion.

To use the motion sensor:

1 Double-click the Pitch Angle block to open a scope.

2 Click the Start simulation button. The scope plot displays a trace of the pitch angle
motion.

To visualize the body motions:
1 In the Simulink Editor window that contains your model, select Simulation > Model
Configuration Parameters.

2 Inthe Simscape Multibody 1G node, select Display machines after updating
diagram and Show animation during simulation.

Click OK.

In the Simulink Editor window that contains your model, select Simulation >
Update Diagram. The Simscape Multibody visualization window opens.

5 Inthe Simscape Multibody menu of the visualization window, select Machine
Display, then Ellipsoids. The display now shows the robot arm's component bodies
as ellipsoids.

6 Click the Start button. The simulation begins. Observe the robot arm motion in the
Simscape Multibody window.
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Import a CAD Stewart Platform Model
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Warning This content is specific to Simscape Multibody First Generation software. First-
generation features are slated to be deprecated and should be avoided.

This example shows you how to import the model of a Stewart platform CAD assembly.
The import procedure makes use of the mech import command. You use the command to
specify the Physical Modeling XML file that Simscape Multibody Link generated during
CAD Export.

Move or copy the stewart platform.xml file into your working MATLAB folder.

To generate a new Simulink model, enter mech _import('stewart platform') at the
MATLAB command line, and wait for the model generation stewart platform to finish.

Review Generated Model and Count DoFs

The complete Stewart platform model contains seven subsystems.
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The subsystems correspond to the subassemblies of the original CAD assembly — the
base plate and the six platform legs.

* The base plate subassembly BaseRingAssembly-1 contains six subassemblies,
modeling a base swivel bearing for each leg.

* The six leg subassemblies, ActuatorAssm, model the upper and lower halves of each
leg and represent part of their DoFs.

For each leg, there are six DoFs. Two pairs of revolutes associated with each leg
represent the two universal joints connecting each leg to the top and base plates,
respectively. Each of these universals has two DoFs.

» At the top level, there are two revolutes, one attached to either end of a leg
subassembly, connecting each leg to the base and top plates, respectively.

* Within each leg subassembly, there are two other revolutes, each one connecting the
leg to the top and base plates, respectively.

One of the revolutes inside the leg subassembly pairs with one of the revolutes outside
the leg assembly to make up a two-DoF universal. These pairs occur twice on each leg,
one connecting the leg to the top plate, the other connecting the leg to the base plate.

* Within each leg subassembly, there is one prismatic, representing the leg's freedom to
expand or contract along its shaft.

» Within each swivel bearing subassembly, itself located within the base ring assembly,
is another revolute representing each leg's freedom to rotate about its shaft.

Each leg has six DoFs. However, the constraints imposed by attaching each leg to fixed
points on the base and top plates, respectively, reduce these to one independent DoF for
each leg — the freedom to expand or contract along its shaft.

* The rotational DoFs associated with the universals at the attachment points are
completely dependent on the leg's prismatic DoF.

* The rotational DoFs associated with the cylindricals in each leg are completely
dependent on the universals at the top and bottom of each leg.

Delete Unnecessary Bodies and Joints

The generated model contains a large number of redundant Root Weld and zero-mass
Root Part blocks. You can delete these and not affect the model's dynamics, as long as you
take care to reconnect the remaining bodies properly after deleting each Weld.
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Add Actuators and Sensors

If you want the motion of the platform to be controlled by something other than gravity,
you need to add the appropriate Actuators to the model. To quantify the model's motion,
you need to make precise measurements with Sensors. You can drive the actuators with
external control signals to model an open-loop controller for the Stewart platform. If you
introduce feedback from the sensors to the actuators, you can model a closed-loop
controller.

Visualize Stewart Platform Motion

Without any external forces acting, apart from gravity, the platform collapses under its
own weight. You can verify this by running and visualizing your Stewart platform model.

1 In the Simulink Editor window that contains your model, select Simulation > Model
Configuration Parameters.

2 In the Simscape Multibody 1G node, select Display machines after updating
diagram and Show animation during simulation.

3 Click OK.

In the Simulink Editor window that contains your model, select Simulation >
Update Diagram. The Simscape Multibody visualization window opens with the
Simscape Multibody controls. The window displays the Stewart platform in its initial
position.

5 Start the simulation by clicking the Start button in the toolbar of either the
visualization window or the model window.

The mobile plate falls under its own weight and reaches the base plate in about 0.2
seconds. Because there is nothing to stop the legs or the top plate, the platform continues
to collapse: the mobile plate falls below the base plate, and the upper and lower parts of
each leg come apart.

This visualization of the Stewart platform uses custom body visualization with the body
geometry files exported from the original CAD assembly.
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Simscape Multibody Visualization of the CAD-Based Stewart Platform (Custom
Body Geometries)
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